Novell
GroupWise® 6

SIX
CLUSTERING

www.novell.com

Novell®
Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to notify any person or entity of such changes.

This product may require export authorization from the U.S. Department of Commerce prior to exporting from the U.S. or Canada.

Copyright © 2001 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

U.S. Patent Nos. 4,555,775; 4,580,218; 5,412,772; 5,701,459; 5,717,912; 5,760,772; 5,870,739; 5,873,079; 5,884,304; 5,903,755; 5,913,209; 5,924,096; 5,946,467; 5,963,938; 6,081,804; 6,138,170; 6,167,393; D393,457 and Patents Pending.

Novell, Inc.
1800 South Novell Place
Provo, UT 84606
U.S.A.

www.novell.com

Clustering
November 2001
103-000193-001

Online Documentation: To access the online documentation for this and other Novell products, and to get updates, see www.novell.com/documentation.
Novell Trademarks

ConsoleOne is a trademark of Novell, Inc.
GroupWise is a registered trademark of Novell, Inc., in the United States and other countries.
NDS is a registered trademark of Novell, Inc., in the United States and other countries.
NetWare is a registered trademark of Novell, Inc., in the United States and other countries.
NLM is a trademark of Novell, Inc.
Novell is a registered trademark of Novell, Inc., in the United States and other countries.
Novell Client is a trademark of Novell, Inc.
Novell Cluster Services is a trademark of Novell, Inc.

Third-Party Trademarks

All third-party trademarks are the property of their respective owners.
## Contents

### Clustering
- Documentation Conventions ......................................................... 9

### 1 Introduction to GroupWise 6 and Novell Cluster Services  ......................................................... 11

### 2 Planning GroupWise in a Clustering Environment  ......................................................... 15
- Meeting NetWare Version Requirements ................................................. 16
- Updating to NetWare 5.1 .................................................................. 17
- Updating to Support Pack 3 ............................................................... 17
- Installing Novell Cluster Services ..................................................... 17
- Planning a New Clustered Domain ...................................................... 19
- Planning a New Clustered Post Office ............................................... 20
- Planning a New Library for a Clustered Post Office .............................. 21
- Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise ........................................... 21
- Ensuring Successful Name Resolution for GroupWise Volumes .......... 23
- Deciding How to Install and Configure the Agents in a Cluster ........... 26
  - Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster ................................................................. 26
  - Determining Appropriate Failover Paths for the Agents .................. 29
  - Deciding Where to Install the Agent Software .................................. 30
  - Deciding Whether to Run the Agents in Protected Memory ............... 32
  - Planning the NLM Agent Installation in a Cluster ............................. 33
- GroupWise Clustering Worksheets .................................................... 34
  - System Clustering Worksheet ........................................................... 35
  - IP Address Worksheet .................................................................... 39
  - Agent Clustering Worksheet ............................................................ 40

### 3 Setting Up a Domain and Post Office in a Cluster ......................................................... 43
- Preparing the Cluster for GroupWise .................................................. 43
  - Ensuring Required Software Versions .............................................. 44
  - Cluster-Enabling Shared Volumes for Use with GroupWise ................ 44
  - Configuring Short Name Resolution ................................................ 44
- Setting Up a New GroupWise System in a Cluster ............................... 47
- Creating a New Secondary Domain in a Cluster ................................ 49
- Creating a New Post Office in a Cluster ............................................ 51
- Installing and Configuring the MTA and the POA in a Cluster ............. 53
  - Installing the Agent Software in a Cluster ........................................ 54
Editing Clustered Agent Startup Files .............................................................. 55
Configuring the GroupWise Volume Resource to Load and Unload the Agents .... 56
Setting Up New Instances of the Agents without Installing the Agent Software ... 62
Testing Your Clustered GroupWise System ..................................................... 65
Managing Your Clustered GroupWise System .................................................. 67
Updating GroupWise Objects with Cluster-Specific Descriptions ...................... 67
Knowing What to Expect in MTA and POA Failover Situations ......................... 69
Other Things You Can Do ................................................................................... 70
Clustering Quick Checklists ............................................................................. 71
GroupWise System Quick Checklist ................................................................. 71
Domain Quick Checklist ................................................................................... 72
Post Office Quick Checklist .............................................................................. 74

4 Implementing the Internet Agent in a Cluster .............................................. 77
Planning the Internet Agent in a Cluster ......................................................... 77
Planning a Domain for the Internet Agent ...................................................... 78
Deciding Whether to Cluster-Enable the Internet Agent Volume ...................... 79
Determining an Appropriate Failover Path for the Internet Agent Volume .......... 79
Planning a Secondary IP Address and Cluster-Unique Port Numbers for the Internet Agent and Its MTA ................................................................. 80
Preparing Your Firewall for the Internet Agent ............................................... 80
Deciding Where to Install the Internet Agent and Its MTA .............................. 81
Deciding Whether to Run the Internet Agent and Its MTA in Protected Memory ... 81
Planning the MTA Installation in a Cluster ....................................................... 82
Planning the Internet Agent Installation in a Cluster ........................................ 82
Setting Up the Internet Agent in a Cluster ...................................................... 83
Cluster-Enabling a Shared Volume for Use with the Internet Agent ................. 83
Creating a Domain for the Internet Agent ...................................................... 84
Installing the MTA for the Internet Agent Domain ......................................... 84
Installing and Configuring the Internet Agent in a Cluster .............................. 84
Testing the Clustered Internet Agent ............................................................. 94
Managing Your Clustered Internet Agent ....................................................... 95
Updating GroupWise Objects with Cluster-Specific Descriptions ..................... 95
Knowing What to Expect in an Internet Agent Failover Situation .................... 97
Internet Agent Clustering Worksheet .............................................................. 98
Internet Agent Quick Checklist ..................................................................... 100

5 Implementing WebAccess in a Cluster ......................................................... 103
Understanding the WebAccess Components .................................................. 103
Planning WebAccess in a Cluster .................................................................. 104
Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster ......... 104
Planning a New Domain for the WebAccess Agent ......................................... 105
Deciding Whether to Cluster-Enable the WebAccess Agent Volume ................. 106
Determining an Appropriate Failover Path for the WebAccess Agent Volume .... 106

6 Clustering
Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA ................................................................. 107
Deciding Where to Install the WebAccess Agent and Its MTA .................................................. 107
Deciding Whether to Run the WebAccess Agent and Its MTA in Protected Memory ............... 108
Planning the MTA Installation in a Cluster .................................................................................... 108
Planning the WebAccess Installation in a Cluster ........................................................................ 108
Setting Up WebAccess in a Cluster ............................................................................................. 110
Cluster-Enabling a Shared Volume for Use with the WebAccess Agent ..................................... 110
Creating a Domain for the WebAccess Agent ............................................................................. 111
Installing the MTA for the WebAccess Agent Domain ................................................................. 111
Installing and Configuring the WebAccess Agent in a Cluster .................................................. 112
Installing and Configuring the WebAccess Application in a Cluster .......................................... 120
Testing Your Clustered WebAccess Installation ......................................................................... 122
Managing WebAccess in a Cluster ............................................................................................... 122
Updating GroupWise Objects with Cluster-Specific Descriptions ............................................. 123
Knowing What to Expect in WebAccess Failover Situations ......................................................... 124
Updating the WebAccess Agent Configuration File (COMMGR.CFG) ....................................... 125
WebAccess Clustering Worksheet ................................................................................................. 126
WebAccess Quick Checklist ........................................................................................................ 129

6 Implementing GroupWise Gateways in a Cluster ................................................................. 131

7 Monitoring a Clustered GroupWise System ................................................................................. 133

8 Backing Up a Clustered GroupWise System with the GroupWise TSA ................................ 135

9 Adding Novell Cluster Services to an Existing GroupWise 6 System ..................................... 137

10 Updating a Clustered GroupWise 5.x System to GroupWise 6 ............................................. 139
Cluster-Enabling GroupWise Volumes ......................................................................................... 139
Updating GroupWise Administration in a Cluster ........................................................................ 140
Updating Domains, Post Offices, and Agents in a Cluster .......................................................... 140
  Sequencing the Update ................................................................................................................. 141
  Preparing for the Update ............................................................................................................. 142
  Installing the Update .................................................................................................................. 142
  Checking Agent Startup Files and the Volume Resource Load Script .................................. 143
  Updating the POA on the Same Server as the MTA ................................................................... 143
  Updating the Internet Agent in a Cluster ..................................................................................... 143
  Updating WebAccess in a Cluster ............................................................................................... 144
    Updating the WebAccess Agent ............................................................................................... 144
    Updating the WebAccess Application ....................................................................................... 145
8 Clustering
Clustering

This GroupWise® 6 Clustering guide helps you install and set up a GroupWise system in the high availability environment provided by Novell® Cluster Services™.

- Chapter 1, “Introduction to GroupWise 6 and Novell Cluster Services,” on page 11
- Chapter 2, “Planning GroupWise in a Clustering Environment,” on page 15
- Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43
- Chapter 4, “Implementing the Internet Agent in a Cluster,” on page 77
- Chapter 5, “Implementing WebAccess in a Cluster,” on page 103
- Chapter 6, “Implementing GroupWise Gateways in a Cluster,” on page 131
- Chapter 7, “Monitoring a Clustered GroupWise System,” on page 133
- Chapter 8, “Backing Up a Clustered GroupWise System with the GroupWise TSA,” on page 135
- Chapter 9, “Adding Novell Cluster Services to an Existing GroupWise 6 System,” on page 137
- Chapter 10, “Updating a Clustered GroupWise 5.x System to GroupWise 6,” on page 139

Documentation Conventions

In Novell documentation, a greater than symbol (>) is used to separate actions within a step and items within a cross-reference path.

A trademark symbol (™, ®, etc.) denotes a Novell trademark. An asterisk denotes a third-party trademark.
Introduction to GroupWise 6 and Novell Cluster Services

Before implementing GroupWise® 6 with Novell® Cluster Services™, make sure you have a solid understanding of Novell Cluster Services by reviewing the following information resources:

- **AppNote:** *An Introduction to Novell Cluster Services* (http://developer.novell.com/research/appnotes/1999/may/01/a990501_.pdf)
- **Product Documentation:** *Novell Cluster Services* (http://www.novell.com/documentation/lg/ncs/index.html)

When you review the information resources recommended above, you discover that clustering employs very specialized terminology. The following brief glossary provides basic definitions of clustering terms and relates them to your GroupWise system:

**cluster:** A grouping of from two to 32 NetWare® servers configured using Novell Cluster Services so that data storage locations and applications can transfer from one server to another without interrupting their availability to users.

**node:** A clustered server; in other words, a single NetWare server that is part of a cluster. In this GroupWise Clustering guide, the terms "clustered server," "server in a cluster," or simply "server" are used instead of the more specialized term "node."

**resource:** An IP address, volume, application, service, and so on, that can function successfully anywhere in the cluster. The volumes where domains and post offices reside are a specific type of cluster resources termed "volume resources." In this GroupWise Clustering guide, the terms "cluster resource" and "volume resource" are used instead of "resource" to avoid confusion with GroupWise resources (such as conference rooms and projectors).
failover: The process of moving cluster resources from a failed server to a functional server so that availability to users is uninterrupted. For example, if the server where the POA is running goes down, the POA and its post office would fail over to a secondary server so that users could continue to use GroupWise. When setting up cluster resources, you need to consider what components need to fail over together in order to continue functioning.

fan-out-failover: The configuration where cluster resources from a failed server fail over to different servers in order to distribute the load from the failed server across multiple servers. For example, if a server runs a cluster resource consisting of a domain and its MTA, another cluster resource consisting of a post office and its POA, and a third cluster resource for WebAccess, each cluster resource could be configured to fail over separately to different secondary servers.

failback: The process of returning cluster resources to their preferred server after the situation causing the failover has been resolved. For example, if a POA and its post office fail over to a secondary server, that cluster resource can be configured to fail back to its preferred server when the problem is resolved.

migration: The process of manually moving a cluster resource from its preferred server to a secondary server for the purpose of performing maintenance on the preferred server, temporarily lightening the load on the preferred server, and so on.

shared disk system: The hardware housing the physical disk volumes that are shared among the clustered servers.

shared volume: A volume in a shared disk system that can be accessed from any clustered server that needs the data stored on it.

cluster-enabled shared volume: A shared volume for which a Volume Resource object has been created in NDS®. The properties of the Volume Resource object provide load and unload scripts for programs installed on the volume, failover/failback/migration policies for the volume, and the failover path for the volume. Cluster-enabling is highly recommended for GroupWise.

GroupWise volume: As used in this GroupWise Clustering guide, a cluster-enabled shared volume that is used for GroupWise, such as for storing a domain, post office, software distribution directory, and so on. This guide also uses the terms Internet Agent volume, WebAccess Agent volume, and gateway volume in a similar manner.
storage area network (SAN): The clustered servers together with their shared disk system and shared volumes.

virtual server: A logical server, rather than a physical server, to which cluster-enabled shared volumes are tied.

active/active mode: The configuration of a clustered application where the application runs simultaneously on multiple servers in the cluster. The active/active mode is recommended when configuring the Netscape* Enterprise Server* for use with GroupWise WebAccess.

active/passive mode: The configuration of a clustered application where the application runs on only one server at a time in the cluster. The GroupWise MTA, POA, Internet Agent, and WebAccess Agent run in active/passive mode because only one instance of each agent/database combination can be running at the same time in the cluster.
Planning GroupWise in a Clustering Environment

The majority of this guide (Chapter 2, “Planning GroupWise in a Clustering Environment,” on page 15 through Chapter 8, “Backing Up a Clustered GroupWise System with the GroupWise TSA,” on page 135) is designed for those who are creating a new GroupWise® system, or at least new domains and post offices, in the context of Novell® Cluster Services™. If you already have an existing GroupWise 6 system and need to configure it to work in a newly installed cluster, see Chapter 9, “Adding Novell Cluster Services to an Existing GroupWise 6 System,” on page 137. If you already have a clustered GroupWise 5.x system and want to update it to GroupWise 6, see Chapter 10, “Updating a Clustered GroupWise 5.x System to GroupWise 6,” on page 139.

When you implement a new GroupWise system or a new domain or post office in a clustering environment, overall GroupWise system design does not need to change substantially. For a review, see "Installing a Basic GroupWise System in the Installation guide. However, the configuration of individual components of your GroupWise system will be significantly different. This section helps you plan the following GroupWise components in a cluster:

- A new GroupWise system consisting of the primary domain and the initial post office
- A new secondary domain
- A new post office
- The GroupWise agents (MTA and POA)

During the planning process, component configuration alternatives will be explained. For example, you may want the domain and post office together on the same shared volume or on different shared volumes. You may want to install the agents to standard SYS:\SYSTEM directories or to manually
created `vol:\SYSTEM` directories on shared volumes where domains and post offices reside. You may or may not need to run the agents in protected memory.

The “System Clustering Worksheet” on page 35 lists all the information you will need as you set up GroupWise in a clustering environment. You should print the worksheet and fill it out as you complete the tasks listed below:

- “Meeting NetWare Version Requirements” on page 16
- “Installing Novell Cluster Services” on page 17
- “Planning a New Clustered Domain” on page 19
- “Planning a New Clustered Post Office” on page 20
- “Planning a New Library for a Clustered Post Office” on page 21
- “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21
- “Ensuring Successful Name Resolution for GroupWise Volumes” on page 23
- “Deciding How to Install and Configure the Agents in a Cluster” on page 26
- “GroupWise Clustering Worksheets” on page 34

After you have completed the tasks and filled out the “System Clustering Worksheet” on page 35, you will be ready to continue with Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43.

**Meeting NetWare Version Requirements**

GroupWise 6 with Support Pack 1 can be clustered on a system that meets the following NetWare® requirements:

- NetWare 5.1
- Support Pack 3

**IMPORTANT:** Novell Cluster Services does not support mixed NetWare versions within a cluster.
As needed, update the NetWare servers that will become part of the cluster you are preparing for your GroupWise system.

- “ Updating to NetWare 5.1” on page 17
- “Updating to Support Pack 3” on page 17

### Updating to NetWare 5.1

If you are still running NetWare 5.0 or earlier, you must upgrade all servers in the cluster to NetWare 5.1 in order to run GroupWise in the cluster. You can purchase NetWare 5.1 at [NetWare 5.1: How to Buy](http://www.novell.com/products/netware/howtobuy.html).

### Updating to Support Pack 3

After NetWare 5.1 is installed on all the servers in the cluster, you must install NetWare 5.1 Support Pack 3. It includes changes that benefit the combination of NetWare 5.1 and GroupWise 6 with Support Pack 1. You can download NetWare 5.1 Support Pack 3 from [TID 295961: NetWare 5.1 Support Pack 3](http://support.novell.com/servlet/tidfinder/2959615).

### Installing Novell Cluster Services

Install Novell Cluster Services by following the instructions provided in "Installation and Setup" in [NetWare Cluster Services Overview and Installation](http://www.novell.com/products/netware/howtobuy.html). The installation process includes:

- Meeting hardware and software requirements
- Setting up a shared disk system
- Creating a new NetWare Cluster object to represent the cluster in NDS®
- Adding servers to the cluster
- Installing the Novell Cluster Services software on all servers in the cluster
Mounting the shared volumes where you will set up GroupWise domains and post offices and install the GroupWise agents

As you install Novell Cluster Services, record key information about the cluster on the System Clustering Worksheet:

**SYSTEM CLUSTERING WORKSHEET**

Under Item 2: NDS Tree for Cluster, record the name of the NDS tree where the new NetWare Cluster object has been created.

Under Item 3: Cluster Name, record the name of the NetWare Cluster object that you created for your GroupWise system.

Under Item 4: Cluster Context, record the full context of the NetWare Cluster object.

Under Item 5: Servers in Cluster, list the servers that you have added to the cluster.

The number of servers and shared volumes that are available in the cluster will strongly influence where you place GroupWise domains and post offices. You have several alternatives:

- Your whole GroupWise system can run in a single cluster.
- Parts of your GroupWise system can run in one cluster while other parts of it run in one or more other clusters.
- Parts of your GroupWise system can run in a cluster while other parts run outside of the cluster, on non-clustered servers.

If you do not have the system resources to run all of your GroupWise system in a clustering environment, you must decide which parts have the most urgent need for the high availability provided by clustering. Here are some suggestions:

- Post offices and their POAs must be available in order for users to access their GroupWise mailboxes. Therefore, post offices and their POAs are excellent candidates for the high availability provided by clustering.
- In a like manner, WebAccess provides user access to GroupWise mailboxes across the Internet through users’ Web browsers. It is another good candidate for clustering.
- Domains and their MTAs are less noticeable to users when they are unavailable (unless users in different post offices happen to be actively
engaged in an e-mail discussion when the MTA goes down). On the other hand, domains and their MTAs are critical to GroupWise administrators, although administrators may be more tolerant of a down server than end users are. Critical domains in your system would be the primary domain and, if you have one, a hub or routing domain. These domains should be in the cluster, even if other domains are not.

- The Internet Agent may or may not require high availability in your GroupWise system, depending on the importance of immediate messaging across the Internet and the use of POP3 or IMAP4 clients by GroupWise users.

There is no right or wrong way to implement GroupWise in a clustering environment. It all depends on the specific needs of your particular GroupWise system and its users.

Planning a New Clustered Domain

The considerations involved in planning a new domain in a clustering environment are essentially the same as for any other environment.

- **Primary Domain:** If you are setting up a new GroupWise system in a clustering environment, you will be creating the primary domain as you complete the tasks in this section. In preparation, review "Planning Your Basic GroupWise System," then print and fill out the "Basic GroupWise System Worksheet" in "Installing a Basic GroupWise System" in the Installation guide. This covers planning the primary domain and an initial post office in the primary domain.

- **Secondary Domain:** If your GroupWise system already exists, you will be creating a new secondary domain. In preparation, review "Planning a New Domain", then print and fill out the "Domain Worksheet" in "Domains" in the Administration guide.

Regardless of the type of domain you are creating, keep in mind the following cluster-specific details as you fill out the worksheet you need:

- When you specify the location for the domain directory (and for a new GroupWise system, the post office directory) on the worksheet, include the shared volume where you want the directory to reside.

- Do not concern yourself with the GroupWise agent information on the worksheet. You will plan the agent installation later. If you are filling out the Basic GroupWise System Worksheet, stop with item 16. If you are filling out the Domain Worksheet, stop with item 10.
When you have completed the worksheet, transfer the key information from the Basic GroupWise System Worksheet or the Domain Worksheet to the System Clustering Worksheet.

---

**SYSTEM CLUSTERING WORKSHEET**

Under **Item 10: Domain Name**, transfer the domain name and database directory to the System Clustering Worksheet.

Under **Item 7: Shared Volume for Domain**, transfer the domain location to the System Clustering Worksheet. You will fill out the rest of the information under item 7 later.

**IMPORTANT:** Do not create the new domain until you are instructed to do so in Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43.

---

### Planning a New Clustered Post Office

The considerations involved in planning a new post office in a clustering environment are essentially the same as for any other environment. The initial post office in a new GroupWise system is planned on the Basic GroupWise System Worksheet. To plan additional new post offices, review "Planning a New Post Office," then print and fill out the "Post Office Worksheet" in "Post Offices" in the Administration guide. When you specify the locations for the post office directories, include the shared volumes where you want the post office directories to reside.

When you have completed the worksheet, transfer key information from the Basic GroupWise System Worksheet or the Post Office Worksheet to the System Clustering Worksheet.

---

**SYSTEM CLUSTERING WORKSHEET**

Under **Item 11: Post Office Name**, transfer the post office name and database location to the System Clustering Worksheet.

If you will create the post office on a different shared volume from where the domain is located, under **Item 8: Shared Volume for Post Office**, transfer the post office location to the System Clustering Worksheet. You will fill out the rest of the information under item 8 later.

**IMPORTANT:** Do not create the new post office until you are instructed to do so in Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43.
Planning a New Library for a Clustered Post Office

The considerations involved in planning a new library in a clustering environment are essentially the same as for any other environment. You can plan a library for a clustered post office by following the standard instructions provided in "Libraries" in the Administration guide and filling out the "Basic Library Worksheet" or the "Full-Service Library Worksheet." Then provide the library information on the System Clustering Worksheet.

<table>
<thead>
<tr>
<th>SYSTEM CLUSTERING WORKSHEET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under Item 14: Library Location, mark where you want to create the library's document storage area.</td>
</tr>
<tr>
<td>If the document storage area will be located outside the post office directory structure, specify a user name and password that the POA can use to access the volume where the document storage area will reside.</td>
</tr>
</tbody>
</table>

**IMPORTANT:** Do not create the new library until you are instructed to do so in Chapter 3, "Setting Up a Domain and Post Office in a Cluster," on page 43.

Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise

Cluster-enabling the shared volumes where domains and post offices reside greatly simplifies GroupWise administration. If you are creating a new GroupWise system, you may also want to cluster-enable shared volumes for the GroupWise administration snap-ins to ConsoleOne™ and for the GroupWise software distribution directory so that these locations are always available within the cluster. To review the concept of cluster-enabled shared volumes, see "Cluster-Enable Volumes" in "Installation and Setup" in NetWare Cluster Services Overview and Installation.

The advantages of cluster-enabling GroupWise volumes include:

- Drive mappings always occur through the virtual server associated with the cluster-enabled volume, rather than through a physical server. This guarantees that you will always be able to map a drive to the domain or post office database no matter which clustered server it is currently located on.
- The GroupWise snap-ins to ConsoleOne will always work no matter which clustered server is running ConsoleOne.
Cluster-enabling the domain volume and installing the GroupWise agents to this volume guarantees that the GroupWise snap-ins to ConsoleOne will always be able to find the configuration files that they need to access.

When you rebuild a domain database or a post office database, you do not need to determine which clustered server the database is currently located on.

Help desk personnel do not need to be trained to determine where GroupWise is running before they connect to a domain to create a new GroupWise user.

When you cluster-enable a volume, additional NDS objects will be created:

<table>
<thead>
<tr>
<th>NDS Object</th>
<th>Object Name and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clusternamem volumenname</td>
<td>A new Volume object will represent the cluster-enabled volume. It will be created by renaming the original Volume object that was tied to a physical server and associating it with a virtual server instead. For example, if your cluster name is GWCLUSTER and your original volume name is GWVOL1, the new Volume object representing the cluster-enabled volume would be named GWCLUSTER_GWVOL1.</td>
</tr>
<tr>
<td>clusternamem volumenname_SERVER</td>
<td>A new Server object will represent the virtual server to which the new cluster-enabled volume is tied. Continuing with the above example, the new Server object representing the virtual server would be named GWCLUSTER_GWVOL1_SERVER.</td>
</tr>
<tr>
<td>volumenname_SERVER.clusternamen</td>
<td>A new Volume Resource object will store property information for the cluster-enabled volume, such as start, failover, and failback mode information and load/unload scripts. These modes and scripts enable the cluster-enabled volume to function much like an independent server; hence, the SERVER portion of its name. Continuing with the above example, the new Volume Resource object would be named GWVOL1_SERVER.GWCLUSTER.</td>
</tr>
</tbody>
</table>

Cluster-enabling the shared volumes used by GroupWise is highly recommended. Throughout the rest of this document, the term "GroupWise volume" means "a cluster-enabled shared volume used by GroupWise."
IMPORTANT: Because cluster-enabling the volumes where domains and post offices reside is so strongly recommended, this documentation does not include the steps for setting up domains and post offices on non-cluster-enabled volumes. If you decide not to cluster-enable GroupWise volumes, you will need to adjust the steps presented in this documentation for your system’s specialized needs. Novell Cluster Services does provide a GroupWise Mail Server template for use when creating GroupWise Cluster Resource objects instead of cluster-enabled Volume Resource objects.

**Ensuring Successful Name Resolution for GroupWise Volumes**

Because you are using cluster-enabled volumes for GroupWise domains and post offices, you must ensure that short name resolution is always successful. For example, in ConsoleOne, if you right-click a Domain object in the GroupWise View and then click Connect, ConsoleOne must be able to resolve the domain location, as provided in the UNC Path field, to the network address of the current, physical location of that domain within your cluster. It is through short name resolution that all GroupWise cluster resources (such as domain and post office volumes) are accessed and managed in ConsoleOne.

A client program (such as ConsoleOne) that runs on a Windows* workstation, can be configured to use several different short name resolution methods. To see which methods are in use at a particular workstation, view the protocol
preferences for the Novell Client™ that is installed on the Windows workstation:

![Novell Client for Windows 2000 Properties](image)

Short name resolution methods that pertain to clustering your GroupWise system are discussed below:

<table>
<thead>
<tr>
<th>Short Name Resolution Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDS</td>
<td>You can use NDS to resolve short names into specific network addresses. However, when using NDS for short name resolution, you must remember to consider current context in the name resolution process. NDS short name resolution works only if your current context is the same as the context of the NDS object you need to access.</td>
</tr>
</tbody>
</table>
Planning GroupWise in a Clustering Environment

**Short Name Resolution Method**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
</table>

**Hosts Files**

Windows uses the following files when performing short name resolution at the workstation:

- **Windows NT/2000:**
  \WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

- **Windows 9.x:**
  \NOVELL\CLIENT32\NWHOSTS

Using these files at the Windows workstation is not a preferred method for TCP/IP name resolution (except perhaps for the administrator's workstation).

However, whenever you cluster-enable a volume, you should add its virtual server to the SYS\ETC\HOSTS file of all servers in the cluster.

**DNS**

Perhaps the most common short name resolution option is Domain Name Service (DNS). As with the HOSTS file, it is good practice to place all of your virtual servers into DNS. However, the underscore (\_) character, a required part of cluster-related object names, is not supported by the DNS RFC. Consequently, some DNS name servers cannot resolve cluster-related object names. (The next version of Novell Cluster Services will allow you to choose the name of the virtual Server object, so you will be able to avoid this issue.)

For short name resolution to work using DNS, the client workstation must either belong to the same DNS zone (such as support.novell.com) as the cluster resource, or the cluster resource zone must be configured in the client’s DNS suffix search path under TCP/IP settings for the workstation.

**SLP**

NetWare 5.x uses Service Location Protocol (SLP) to advertise service information across TCP/IP-based networks, which provides short name resolution of TCP/IP-based cluster resources within the network.

Novell Cluster Services does not currently propagate virtual server information into SLP by default. If you want to propagate virtual server information to SLP, you can run the (unsupported) CVSBIND utility, which gives you reliable short name resolution within your cluster regardless of shortcomings you may encounter with other name resolution methods. (The next version of Novell Cluster Services will propagate virtual server information into SLP by default, so you will be able to avoid this issue.)
Specific setup instructions for each of these short name resolution methods will be provided in Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43.

SYSTEM CLUSTERING WORKSHEET

Under Item 9: IP Address Resolution Methods, mark which methods you want to implement in order to resolve the locations stored as UNC paths in ConsoleOne into physical network addresses in your system.

Deciding How to Install and Configure the Agents in a Cluster

There are several cluster-specific issues to consider as you plan to install the NLM™ MTA and POA in your clustered GroupWise system:

- “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on page 26
- “Determining Appropriate Failover Paths for the Agents” on page 29
- “Deciding Where to Install the Agent Software” on page 30
- “Deciding Whether to Run the Agents in Protected Memory” on page 32
- “Planning the NLM Agent Installation in a Cluster” on page 33

Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster

The GroupWise agents listen on all IP addresses, both primary and secondary, that are bound to the server on their specified port numbers. This means that any time there is a possibility of two of the same type of agent loading on the same server, it is important that each agent use a cluster-unique port number, even though each agent is using a unique secondary IP address. The best way for you to avoid port conflicts is to plan your cluster so that each agent in the cluster runs on a cluster-unique port. Print out a copy of the “IP Address Worksheet” on page 39 to help you plan secondary IP addresses and cluster-unique port numbers for all GroupWise agents.

The following filled-out version of the IP Address Worksheet illustrates one way this can be done:
This example places the Development post office on the same server and on
the same GroupWise volume with the Provo1 domain; therefore, the Provo1

<table>
<thead>
<tr>
<th>Domain</th>
<th>MTA IP Address</th>
<th>MTA MTP Port</th>
<th>MTA HTTP Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provo1</td>
<td>123.45.67.81</td>
<td>7100</td>
<td>7180</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Post Office</th>
<th>POA IP Address</th>
<th>POA C/S Port</th>
<th>POA MTP Port</th>
<th>POA HTTP Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development</td>
<td>(same as MTA)</td>
<td>1677</td>
<td>7101</td>
<td>7181</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>123.45.67.82</td>
<td>1678</td>
<td>7102</td>
<td>7182</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Internet Agent</th>
<th>GWIA IP Address</th>
<th>MTA MTP Port</th>
<th>MTA Live Remote Port</th>
<th>MTA HTTP Port</th>
<th>GWIA HTTP Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>GWIA Domain MTA</td>
<td>123.45.67.83</td>
<td>7110</td>
<td>7677</td>
<td>7183</td>
<td>N/A</td>
</tr>
<tr>
<td>Internet Agent (GWIA)</td>
<td>(same as MTA)</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>9850</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WebAccess Agent</th>
<th>WebAccess IP Address</th>
<th>MTA MTP Port</th>
<th>MTA HTTP Port</th>
<th>WebAccess Agent Port</th>
<th>WebAccess HTTP Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebAccess Domain MTA</td>
<td>123.45.67.84</td>
<td>7120</td>
<td>7184</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>WebAccess Agent (GWINTER)</td>
<td>(same as MTA)</td>
<td>N/A</td>
<td>N/A</td>
<td>7205</td>
<td>7205 (same as agent)</td>
</tr>
</tbody>
</table>
MTA and the Development POA can use the same secondary IP address. The Manufacturing post office is placed on a different server on a different GroupWise volume; therefore the Manufacturing post office has a different secondary IP address.

The example also illustrates that the MTA, the POA, and the Internet Agent use different port numbers for agent ports and HTTP ports. In contrast, the WebAccess Agent uses the same port number for the agent port and the HTTP port.

The example uses default port numbers where possible. For example, the default MTA message transfer port is 7100 and the default POA client/server port is 1677. Incrementing port numbers are used in the example when multiple components have the same type of ports. For example, port numbers 1677 and 1678 are both POA client/server ports and port numbers 7180 through 7184 are all HTTP ports. Incrementing from the default port numbers generates unique, though related, port numbers.

If you are going to set up a GroupWise name server to help GroupWise clients locate their post offices, make sure that the default POA port number of 1677 is used somewhere in the cluster. For more information, see "Configuring a GroupWise Name Server" in "Post Office Agent" in the Administration guide.

**IP ADDRESS WORKSHEET**

Fill out the "IP Address Worksheet" on page 39 to help you plan secondary IP addresses and cluster-unique port numbers for all GroupWise agents in the cluster. (MTA, POA, Internet Agent, WebAccess Agent).

After you have filled out the IP Address Worksheet, transfer the secondary IP addresses and cluster-unique port numbers from the IP Address Worksheet to the System Clustering Worksheet and the Agent Clustering Worksheet so that they will be available in the sequence in which you will need them as you set up GroupWise in a cluster.
Determining Appropriate Failover Paths for the Agents

By default, a GroupWise volume is configured to have all servers in the cluster in its failover path, organized in ascending alphanumeric order. Only one server at a time can have a GroupWise volume mounted and active. If a GroupWise volume’s preferred server fails, the volume fails over to the next server on the failover path. You will want to customize the failover path for each GroupWise volume based on the fan-out-failover principle.

When a server fails, its volumes should not all fail over together to the same secondary server. Instead, the volumes should be distributed across multiple servers in the cluster. This prevents any one server from shouldering the entire processing load typically carried by another server. In addition, some volumes should never have the potential of being mounted on the same server during a failover situation. For example, a post office and POA that service a large number of very active GroupWise client users should never fail over to a server where another very large post office and heavily loaded POA reside. If it did, users on both post offices would notice a decrease in responsiveness of the GroupWise client.
Deciding Where to Install the Agent Software

When you install the NLM MTA and POA in a clustering environment, you can choose between two different installation locations:

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYS:\SYSTEM on each server in the cluster</td>
<td>This is the default location provided by the Agent Installation program. Because the agents must be installed on each server where they might need to run during a failover situation, you will need to do one of the following if you select this alternative:</td>
</tr>
<tr>
<td></td>
<td>• Run the Agent Installation program, then copy the agent software and startup files to each server that is on a GroupWise volume’s failover path.</td>
</tr>
<tr>
<td></td>
<td>• Run the Agent Installation program multiple times in order to install the agent software and to create the agent startup files on each server that is on a GroupWise volume’s failover path.</td>
</tr>
<tr>
<td>SYSTEM directory on each GroupWise volume</td>
<td>If you create a vol:\SYSTEM directory on a GroupWise volume, the agent software and startup files fail over and back with the domains and post offices that the agents service.</td>
</tr>
<tr>
<td></td>
<td>Unless you have a very small GroupWise system with all domains and post offices on a single GroupWise volume, you will still need to install the agent software multiple times, once to each GroupWise volume.</td>
</tr>
</tbody>
</table>

A simple way to look at the agent location alternatives would be that if you have fewer servers on failover paths than you have GroupWise volumes for
domains and post offices, then it is most efficient to install the agent software to the servers. Conversely, if you have fewer GroupWise volumes than you have servers on failover paths, then it would be most efficient to install the agent software to the GroupWise volumes. However, there are issues to consider that extend beyond efficiency during installation.

The following sections can help you choose which installation location would be best for your clustered GroupWise system:

- “Advantages of a vol:\SYSTEM Directory on Each GroupWise Volume” on page 31
- “Disadvantages of a vol:\SYSTEM Directory on Each GroupWise Volume” on page 31
- “Recommendation” on page 32

**Advantages of a vol:\SYSTEM Directory on Each GroupWise Volume**

Using a vol:\SYSTEM directory on each GroupWise volume has several advantages:

- If you change information in the agent startup files, you only need to change it in one place, not on every server on any GroupWise volume’s failover path.
- Having the agent startup files on the same GroupWise volume as the domain or post office makes them easy to find.
- When you update the agent software, you only need to update it in one place for a particular domain or post office, not on every server on a GroupWise volume’s failover path. This prevents the potential problem of having a domain or post office fail over to a location where the agents could be running a different version of the agent software.
- If you ever need to add or replace a physical server in the cluster, you only need to install NetWare and Novell Cluster Services to the new server, then add that clustered server to the appropriate failover paths. No extra GroupWise configuration is necessary because there are no SYS:\SYSTEM dependencies for the GroupWise agents.
- If you want to back up the GroupWise software, you do not have to include the SYS:\SYSTEM directory in the backup.

**Disadvantages of a vol:\SYSTEM Directory on Each GroupWise Volume**

Installing the agents on a GroupWise volume does have some disadvantages:
• GroupWise administrators who are used to the GroupWise agents being installed in SYS:\SYSTEM may be confused by not finding them there in the clustered GroupWise system.

• You must remember where you installed the GroupWise agents when you update the agent software. Accidentally installing a GroupWise Support Pack to SYS:\SYSTEM would not have the desired results if the original agent software was installed to the vol:\SYSTEM directory on a GroupWise volume.

**Recommendation**

Whichever method you choose, be consistent throughout the entire cluster. Either put all the GroupWise agents on the GroupWise volumes with the domains and post offices they service, or put them all in SYS:\SYSTEM directories. If you put them on GroupWise volumes, make sure there are no agent files in SYS:\SYSTEM directories to confuse the issue at a later time.

Even if you choose to install the agents to multiple SYS:\SYSTEM directories, you can still store the agent startup files on the GroupWise volumes. The big advantage of this approach is that you only have one startup file to modify per agent.

<table>
<thead>
<tr>
<th>AGENT CLUSTERING WORKSHEET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under Item 1: Agent Installation Location, mark whether you will install the agent software to a vol:\SYSTEM directory on a GroupWise volume or to SYS:\SYSTEM on each server in the cluster. If necessary, specify where the agent startup files will be stored.</td>
</tr>
<tr>
<td>Under Item 2: Domain Name, transfer the domain name and location from the System Clustering Worksheet to the Agent Clustering Worksheet.</td>
</tr>
<tr>
<td>Under Item 5: Post Office Name, transfer the post office name and location from the System Clustering Worksheet to the Agent Clustering Worksheet.</td>
</tr>
</tbody>
</table>

**Deciding Whether to Run the Agents in Protected Memory**

On a NetWare server, using protected memory allows you to create isolated memory spaces where NLM programs can run without affecting other NLM programs running on the same server. This contributes to the high availability of the server. Using protected memory has the following advantages:

• When using protected memory, the server can restart a specific memory space if any NLM program within that memory space abends. This allows
for recovery without failing the entire server, which enhances both up
time and database integrity.

- Using protected memory gives you the ability to unload a single instance
  of an agent, rather than all instances.

If you have any possibility of the same type of GroupWise agent loading
multiple times on any server in the cluster, you must use protected memory so
that you can unload agents individually. Check your failover paths (Agent
Worksheet items 3 and 6) for failover combinations where multiple instances
of the same type of agent might need to run on the same server.

Protected memory does result in higher memory utilization (about 5% to 10%)
and a slight performance penalty. Make sure your clustered servers have
sufficient memory to handle the number of memory spaces that may reside on
them. Keep in mind that if you load the MTA and the POA in different
memory spaces, the agent engine (GWENN3.NLM) will load twice on the
server. Remember to provide memory for any GroupWise volumes that could
fail over to a server, in addition to that server’s regular processing load.

<table>
<thead>
<tr>
<th>AGENT CLUSTERING WORKSHEET</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Under Item 8: Load Agents in Protected Memory?</strong>, mark whether or not you need to run the GroupWise agents in protected memory.</td>
</tr>
</tbody>
</table>

If you will use protected memory, provide one or two unique protected memory space names. If you will create the domain and post office on the same GroupWise volume, the MTA and POA can use the same memory space, although this is not required. If you will create the domain and post office on different GroupWise volumes, the MTA and POA must use different memory spaces.

If you will use protected memory, specify a user name and password that the POA can use to access the volumes where its post office and, optionally, a remote document storage will reside.

---

**Planning the NLM Agent Installation in a Cluster**

Aside from the cluster-specific issues discussed in the preceding sections, the considerations involved in planning to install the GroupWise NLM agents are the same in a clustering environment as for any other environment. Review "Planning the NLM Agents," then print and fill out the "NLM Agent Worksheet" in "Installing GroupWise Agents" in the Installation guide for each location where you will install the NLM MTA and/or POA.
Fill out the NLM Agent Worksheet, taking into account the following cluster-specific issues:

**NLM AGENT WORKSHEET**

Under **Item 1: Agents and Locations**, mark POA Local to Post Office and MTA Local to Domain. In a clustering environment, a domain or post office and its agent must reside on the same GroupWise volume in order to fail over together.

Under **Item 2: Installation Path**, take into account your decision based on “Deciding Where to Install the Agent Software” on page 30.

Under **Item 3: Configure GroupWise Agents for Clustering**, mark Yes. This will cause the Agent Installation program to customize the agent startup files for clustering.


Under **Item 9: Update AUTOEXEC.NCF File**, mark No.

Under **Item 10: Launch GroupWise Agents Now**, mark No. You will configure the agents to run in protected mode later.

**IMPORTANT:** Do not install the NLM agent software until you are instructed to do so in Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43.

Continue with Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43.

**GroupWise Clustering Worksheets**

- “System Clustering Worksheet” on page 35
- “IP Address Worksheet” on page 39
- “Agent Clustering Worksheet” on page 40
## System Clustering Worksheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) NetWare Version Requirements for Cluster:</td>
<td>Mark any updates the servers in your cluster need in order to meet the system requirements for a GroupWise system in a cluster.</td>
</tr>
<tr>
<td>• NetWare 5.1</td>
<td>For more information, see “Meeting NetWare Version Requirements” on page 16.</td>
</tr>
<tr>
<td>• NetWare 5.1 Support Pack 3 Update to GroupWise 6 Support Pack 1?</td>
<td></td>
</tr>
<tr>
<td>2) NDS Tree for Cluster:</td>
<td>Record the NDS tree where you created the new Novell Cluster object when you installed Novell Cluster Services.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Installing Novell Cluster Services” on page 17</td>
</tr>
<tr>
<td>3) Cluster Name:</td>
<td>Record the name of the name of the new NetWare Cluster object that you created for your GroupWise system.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Installing Novell Cluster Services” on page 17</td>
</tr>
<tr>
<td>4) Cluster Context:</td>
<td>Record the full context where you created the new NetWare Cluster object.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Installing Novell Cluster Services” on page 17</td>
</tr>
<tr>
<td>5) Servers in Cluster</td>
<td>List the servers that are part of the cluster that you set up for your GroupWise system.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Installing Novell Cluster Services” on page 17</td>
</tr>
<tr>
<td>Item</td>
<td>Explanation</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>6) Shared Volumes for GroupWise Administration:</td>
<td>Specify the names <em>(cluster_volume)</em> of the shared volumes where the GroupWise administration snap-ins to ConsoleOne and the GroupWise software distribution directory will reside.</td>
</tr>
<tr>
<td>• Yes (highly recommended) Cluster volume IP addresses</td>
<td>For cluster-enabling, specify the IP addresses of the virtual servers <em>(volume_SERVER.cluster)</em> to which the cluster-enabled volumes are tied.</td>
</tr>
<tr>
<td>• No</td>
<td>For more information, see “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21.</td>
</tr>
<tr>
<td>GroupWise Administration Snap-ins to ConsoleOne</td>
<td></td>
</tr>
<tr>
<td>• PUBLIC directory</td>
<td></td>
</tr>
<tr>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td>GroupWise Software Distribution Directory</td>
<td></td>
</tr>
<tr>
<td>• <code>\GRPWISE\SOFTWARE</code> directory</td>
<td></td>
</tr>
<tr>
<td>• Other</td>
<td></td>
</tr>
<tr>
<td>7) Shared Volume for Domain:</td>
<td>Specify the name <em>(cluster_volume)</em> of the shared volume where the GroupWise domain will reside.</td>
</tr>
<tr>
<td>Cluster Enabled?</td>
<td>For cluster-enabling, specify the IP addresses of the virtual server <em>(volume_SERVER.cluster)</em> to which the cluster-enabled volume is tied.</td>
</tr>
<tr>
<td>• Yes (highly recommended) Cluster volume IP address</td>
<td>For more information, see “Planning a New Clustered Post Office” on page 20 and “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21.</td>
</tr>
<tr>
<td>• No</td>
<td></td>
</tr>
<tr>
<td>Post Office on Same Volume as Domain?</td>
<td></td>
</tr>
<tr>
<td>• Yes</td>
<td></td>
</tr>
<tr>
<td>• No</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Explanation</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>8) Shared Volume for Post Office: Cluster Enabled?</td>
<td>Specify the name (<em>cluster_volume</em>) of the shared volume where the GroupWise post office will reside. For cluster-enabling, specify the IP addresses of the virtual server (<em>volume_SERVER.cluster</em>) to which the cluster-enabled volume is tied. For more information, see “Planning a New Clustered Post Office” on page 20 and “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21.</td>
</tr>
<tr>
<td>• Yes (highly recommended) Cluster volume IP address</td>
<td></td>
</tr>
<tr>
<td>• No</td>
<td></td>
</tr>
<tr>
<td>9) IP Address Resolution Methods:</td>
<td>Mark the short name address resolution methods you want to implement to ensure that the UNC paths stored in ConsoleOne can be successfully resolved into physical network addresses. For more information, see “Ensuring Successful Name Resolution for GroupWise Volumes” on page 23</td>
</tr>
<tr>
<td>• NDS</td>
<td></td>
</tr>
<tr>
<td>• HOSTS File</td>
<td></td>
</tr>
<tr>
<td>• DNS</td>
<td></td>
</tr>
<tr>
<td>• SLP (highly recommended)</td>
<td></td>
</tr>
<tr>
<td>10) Domain Name: Domain Database Location:</td>
<td>Specify a unique name for the domain. Specify the directory on the GroupWise volume where you want to create the new domain. For more information, see “Planning a New Clustered Domain” on page 19.</td>
</tr>
<tr>
<td>11) Post Office Name: Post Office Database Location:</td>
<td>Specify a unique name for the post office. Specify the directory on the GroupWise volume where you want to create the post office. For more information, see “Planning a New Clustered Post Office” on page 20.</td>
</tr>
</tbody>
</table>
12) Document Storage Area Location:
- At the post office
- Outside the post office
- Separate post office

If you need a library for a clustered post office, mark where you want to create its document storage area and provide a directory if necessary.

Document Storage Area Access
- POA /user setting
- POA /password setting

For more information, see “Planning a New Library for a Clustered Post Office” on page 21.
## IP Address Worksheet

<table>
<thead>
<tr>
<th>Domain</th>
<th>MTA IP Address</th>
<th>MTA MTP Port</th>
<th>MTA HTTP Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post Office</td>
<td>POA IP Address</td>
<td>POA C/S Port</td>
<td>POA MTP Port</td>
</tr>
<tr>
<td>Internet Agent</td>
<td>GWIA IP Address</td>
<td>MTA MTP Port</td>
<td>MTA Live Remote Port</td>
</tr>
<tr>
<td>Internet Agent (GWIA)</td>
<td>(same)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>WebAccess Agent</td>
<td>WebAccess IP Address</td>
<td>MTA MTP Port</td>
<td>MTA HTTP Port</td>
</tr>
<tr>
<td>WebAccess Domain MTA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WebAccess Agent (GWINTER)</td>
<td>(same)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
## Agent Clustering Worksheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Agent Installation Location:</td>
<td>Mark the location where you will install the agent software. If necessary, specify the location where you will consolidate multiple agent startup files on a GroupWise volume. For more information, see “Deciding Where to Install the Agent Software” on page 30.</td>
</tr>
<tr>
<td>• vol:\SYSTEM on GroupWise volume</td>
<td></td>
</tr>
<tr>
<td>• SYS:\SYSTEM on each server</td>
<td></td>
</tr>
<tr>
<td>Consolidate multiple startup files on</td>
<td></td>
</tr>
<tr>
<td>GroupWise volume?</td>
<td></td>
</tr>
<tr>
<td>2) Domain Name:</td>
<td>Transfer this information from the System Clustering Worksheet (item 10).</td>
</tr>
<tr>
<td>Domain Location:</td>
<td></td>
</tr>
<tr>
<td>3) Domain Failover Path:</td>
<td>List other servers in the cluster where the GroupWise domain and its MTA could fail over. For more information, see “Determining Appropriate Failover Paths for the Agents” on page 29.</td>
</tr>
<tr>
<td>4) MTA Network Information:</td>
<td>Gather the MTA network address information from the “IP Address Worksheet” on page 39. For more information, see “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on page 26.</td>
</tr>
<tr>
<td>• MTA IP address</td>
<td></td>
</tr>
<tr>
<td>• MTA message transfer port</td>
<td></td>
</tr>
<tr>
<td>• MTA HTTP port</td>
<td></td>
</tr>
<tr>
<td>5) Post Office Name:</td>
<td>Transfer this information from the System Clustering Worksheet (item 11).</td>
</tr>
<tr>
<td>Post Office Location:</td>
<td></td>
</tr>
<tr>
<td>6) Post Office Failover Path:</td>
<td>List other servers in the cluster where the GroupWise post office and its POA could fail over. For more information, see “Determining Appropriate Failover Paths for the Agents” on page 29.</td>
</tr>
<tr>
<td>Post Office Failover Path:</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Explanation</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>7) POA Network Information:</td>
<td>Gather the POA network address information from the “IP Address Worksheet” on page 39. For more information, see “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on page 26.</td>
</tr>
<tr>
<td>• POA IP address</td>
<td></td>
</tr>
<tr>
<td>• POA client/server port</td>
<td></td>
</tr>
<tr>
<td>• POA message transfer port</td>
<td></td>
</tr>
<tr>
<td>• POA HTTP port</td>
<td></td>
</tr>
<tr>
<td>8) Load Agents in Protected Memory?</td>
<td>Mark whether you need to run the agents in protected memory. If so, specify a unique address space for each agent. For the POA, specify a user name and password. For more information, see “Deciding Whether to Run the Agents in Protected Memory” on page 32.</td>
</tr>
<tr>
<td>• No</td>
<td></td>
</tr>
<tr>
<td>• Yes</td>
<td></td>
</tr>
<tr>
<td>MTA protected address space</td>
<td></td>
</tr>
<tr>
<td>POA protected address space</td>
<td></td>
</tr>
<tr>
<td>POA /user setting</td>
<td></td>
</tr>
<tr>
<td>POA /password setting</td>
<td></td>
</tr>
</tbody>
</table>
Setting Up a Domain and Post Office in a Cluster

You should have already reviewed “Planning GroupWise in a Clustering Environment” on page 15 and filled out the “System Clustering Worksheet” on page 35, the “IP Address Worksheet” on page 39, and the “Agent Clustering Worksheet” on page 40. You are now ready to complete the following tasks to set up GroupWise® in a clustering environment:

- “Preparing the Cluster for GroupWise” on page 43
- “Setting Up a New GroupWise System in a Cluster” on page 47
- “Creating a New Secondary Domain in a Cluster” on page 49
- “Creating a New Post Office in a Cluster” on page 51
- “Installing and Configuring the MTA and the POA in a Cluster” on page 53
- “Testing Your Clustered GroupWise System” on page 65
- “Managing Your Clustered GroupWise System” on page 67
- “Other Things You Can Do” on page 70

Preparing the Cluster for GroupWise

After you have installed Novell® Cluster Services™, as described in "Installation and Setup" in NetWare Cluster Services Resource Configuration Guide, complete the following tasks to prepare the cluster for your GroupWise system:

- “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 44
- “Configuring Short Name Resolution” on page 44
Ensuring Required Software Versions

Double-check each server in the cluster to make sure it meets the requirements described in “Meeting NetWare Version Requirements” on page 16.

To verify the NetWare and Support Pack levels on each server, at the console prompt, type:

version

Cluster-Enabling Shared Volumes for Use with GroupWise

To cluster-enable a shared volume for use with GroupWise:

1. Select a System Clustering Worksheet item (6, 7, or 8) where you selected Yes under Cluster Enabled?.

2. Complete the steps in "Cluster-Enable Volumes" in "Setting Up NetWare Cluster Services" in NetWare Cluster Services Overview and Installation. Keep in mind these GroupWise-specific details:
   - In Step 3 in "Cluster-Enable Volumes" use the shared volume for the GroupWise domain, post office, or administrative directory.
   - In Step 4 in "Cluster-Enable Volumes," use the cluster volume IP address for the GroupWise volume.
   - In Step 5 in "Cluster-Enable Volumes," use the volume failover path for the GroupWise volume.

For a review of the new NDS objects that are created when you cluster-enable a shared volume, see “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21.

3. Repeat Step 1 and Step 2 above for the other shared volumes on your System Clustering Worksheet that need to be cluster-enabled.

4. Continue with “Configuring Short Name Resolution” on page 44.

Configuring Short Name Resolution

To ensure that GroupWise volumes are always locatable, configure the short name resolution methods that you want to rely on for GroupWise (System Clustering Worksheet item 9):

- “NDS” on page 45
- “Hosts Files” on page 45
After configuring your selected short name resolution methods, continue with the task you need to perform:

- “Setting Up a New GroupWise System in a Cluster” on page 47
- “Creating a New Secondary Domain in a Cluster” on page 49
- “Creating a New Post Office in a Cluster” on page 51

### NDS

Most commonly, you will use NDS® to resolve the UNC path of a volume into its network address. For example, on the workstation where you run ConsoleOne™, you would need to map a drive to the location of a domain directory so that ConsoleOne can access the domain database. You could use a MAP command as shown in the example below:

**Syntax:**

```
MAP drive: = .cluster_volume.context
```

**Example:**

```
MAP M: = .GWCLUSTER_GWVOL1.GW Servers
```

When specifying the map commands, use System Clustering Worksheet item 3 for `cluster`. Use System Clustering Worksheet item 7 or 8 for each `volume` where a domain or post office resides. Use System Clustering Worksheet item 4 for `context`.

### Hosts Files

Each GroupWise volume where you plan to create a domain or post office has been associated with a virtual server. Add lines for the new virtual servers to one or more of the following files as needed:

- **NetWare:**
  SYS\ETC\HOSTS
  (on all servers in the cluster; recommended)

- **Windows NT/2000:**
  \WINNT\SYSTEM32\DRIVERS\ETC\HOSTS
  (on the administrator’s workstation only; optional)
Windows 9.x:
\NOVELL\CLIENT32\NWHOSTS
(on the administrator’s workstation only; optional)

The lines you add to a HOSTS file could look similar to the following example
(all on one line, of course):

Syntax:
IP_address cluster_volume_SERVER.context
cluster_volume_SERVER

Remember that cluster_volume_SERVER is the name of the virtual server
created when you cluster-enabled the volume.

Example:
123.45.67.81
GWCLUSTER_GWVOL1_SERVER.GWCLUSTER.COM
GWCLUSTER_GWVOL1_SERVER

When specifying the lines in the HOSTS files, use System Clustering
Worksheet item 7 or 8 for each IP_address and volume where a domain or post
office resides. Use System Clustering Worksheet item 3 for cluster. Use
System Clustering Worksheet item 4 for context.

DNS

Because your DNS server supports the underscore character, you can add all
your new virtual servers to DNS. Then you could use a MAP command as
shown in the example below (all on one line, of course):

Syntax:
MAP drive: =
\\volume_SERVER.cluster.COM\\volume

Remember that volume_SERVER is the name of the Volume Resource object
created when you cluster-enabled the volume. A cluster-enabled volume can
function like a server, as these commands illustrate.

Example:
MAP M: =
\\GWVOL1_SERVER.GWCLUSTER.COM\\GWVOL1

Or, if the ConsoleOne workstation is in the same DNS domain as the
GroupWise volume:
Syntax:
MAP drive: = \\volume_SERVER\volume

Example:
MAP M: = \GWVOL1_SERVER\GWVOL1

When specifying the MAP commands you will need, use System Clustering Worksheet item 7 or 8 for each volume where a domain or post office resides. Use System Clustering Worksheet item 3 for cluster.

SLP

Novell Cluster Services does not currently propagate virtual server information into SLP by default. If you want to use SLP for name resolution, you must download the (unsupported) CVSBIND utility from the Technical Information Document NWCS Bindery Tool (http://support.novell.com/cgi-bin/search/searchtid.cgi/?2957434.htm). Install CVSBIND according to the instructions included with the download, then determine the server-specific commands you will need to use with CVSBIND.

Syntax:
CVSBIND ADD cluster_volume_SERVER IP_address
CVSBIND DEL cluster_volume_SERVER IP_address

Remember that cluster_volume_SERVER is the name of the virtual server created when you cluster-enabled the volume.

Example:
CVSBIND ADD GWCLUSTER_GWVOL1_SERVER 123.45.67.81
CVSBIND DEL GWCLUSTER_GWVOL1_SERVER 123.45.67.81

Later, in “Modifying the Volume Resource Load Script for the Agents” on page 56 and “Modifying the Volume Resource Unload Script for the Agents” on page 58, you will need to add the CVSBIND commands to the load and unload scripts for GroupWise volume resources.

Setting Up a New GroupWise System in a Cluster

The GroupWise Installation Advisor walks you through setting up the primary domain and an initial post office in the primary domain. You may be creating your primary domain and initial post office on the same GroupWise volume or on two different volumes. After you have created the primary domain and initial post office and installed the GroupWise agents, you can create additional secondary domains and post offices as needed.
To set up the primary domain and initial post office for a new GroupWise system in a clustering environment:

1. If necessary, map a drive to each GroupWise administration volume
   (System Clustering Worksheet item 6).

2. Map a drive to the GroupWise volume for the domain (System Clustering Worksheet item 7) and, if needed, to the GroupWise volume for the post office (System Clustering Worksheet item 8), where the primary domain and the initial post office for your new GroupWise system will be created.

   The GroupWise volume name will be `cluster_volume`. For assistance with mapping a drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 44.

3. Create the domain directory (System Clustering Worksheet item 10) and the post office directory (System Clustering Worksheet item 12).

4. Run the GroupWise Installation Advisor to set up your initial GroupWise system, following the steps provided in "Setting Up Your Basic GroupWise System" in "Installing a Basic GroupWise System" in the Installation guide. Keep in mind the following cluster-specific details:
   - When you specify the ConsoleOne directory and the software distribution directory, be sure to browse to each location through the GroupWise volume accessed in Step 1 above.
   - When you specify the domain directory and post office directory, be sure to browse through the GroupWise volume accessed in Step 2 to select the directory created in Step 3 above.
   - For the post office link type, select TCP/IP Link.
   - When providing the MTA and POA network address information, use the Agent Clustering Worksheet that you filled out during “Deciding How to Install and Configure the Agents in a Cluster” on page 26. The information you provide will be used to configure the MTA and POA objects in the domain and post office even though you have not yet installed the agent software.
   - Do not worry about creating users in the post office at this time.
   - In the Summary dialog box, the domain directory and post office directory that you browsed to should display as UNC paths using the virtual server name with the GroupWise volume.
When you have finished creating the primary domain and the initial post office, continue with installing the GroupWise Agents, starting with Step 4 on page 54 in “Installing and Configuring the MTA and the POA in a Cluster” on page 53.

Creating a New Secondary Domain in a Cluster

After you have set up the primary domain and initial post office, as described in “Setting Up a New GroupWise System in a Cluster” on page 47, you can create additional secondary domains as needed.

To create a new secondary domain in a clustering environment:

1 Map a drive to the GroupWise volume for the domain (System Clustering Worksheet item 7) where the new secondary domain will be created.

The GroupWise volume name will be \cluster\volume. For assistance with mapping a drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 44.

2 Create the domain directory (System Clustering Worksheet item 10).

3 If you selected vol:\SYSTEM on GroupWise Volume as the agent installation location (under Agent Clustering Worksheet item 1), create the vol:\SYSTEM directory on the GroupWise volume accessed in Step 1. or
If you selected SYS:\SYSTEM on Each Server, decide which server you will install the agents to first.

4 In ConsoleOne, connect to the primary domain in your GroupWise system, as described in "Connecting to a Domain" in "Domains" in the Administration guide.

5 Create the new domain, following the steps provided in "Creating the New Domain" in "Domains" in the Administration guide. Keep in mind the following cluster-specific details:
   - Use the Domain Worksheet you filled out during “Planning a New Clustered Domain” on page 19 to fill in the fields in the Create GroupWise Domain dialog box.
   - In the Domain Database Location field, be sure to browse through the drive you mapped in Step 1 to the domain directory you created in Step 2 above.
   - In the Link to Domain field, link the new domain to the primary domain of your GroupWise system.

6 Click the new Domain object > modify the MTA object, following the steps provided in "Configuring the MTA for TCP/IP" in "Message Transfer Agent" in the Administration guide.

Refer to the Agent Clustering Worksheet that you filled out during “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on page 26 for the secondary IP address and cluster-unique port numbers that you need to provide.

7 Use the Link Configuration tool to change the links from the new domain to all other domains in the cluster to direct TCP/IP links, following the steps provided in "Changing the Link Protocol between Domains to TCP/IP" in "Message Transfer Agent" in the Administration guide.

Although a complete mesh link configuration is the most efficient, it may not be feasible in all situations. Set up as many direct TCP/IP links as possible for best MTA performance in the cluster.

8 Make sure you are still connected to the primary domain.

9 Rebuild the domain database for the new domain, following the steps provided in "Rebuilding Domain or Post Office Databases" in "Databases" in the Administration guide. Be sure to browse to the database location through the virtual server that was created when you cluster-enabled the GroupWise volume.
The database rebuild is necessary in order to transfer the MTA configuration information and the domain link information into the secondary domain database, because the MTA for the new domain is not yet running.

Continue with “Creating a New Post Office in a Cluster” on page 51.

Creating a New Post Office in a Cluster

You can create a new post office on the same GroupWise volume where its domain resides or on a separate GroupWise volume. If the post office and its domain are on the same GroupWise volume, they fail over together. If they are on separate GroupWise volumes, they fail over separately.

To create a new post office in a clustering environment:

1. If you selected Yes for Post Office on Same Volume as Domain? (under System Clustering Worksheet item 7), map a drive to the GroupWise volume for the domain (System Clustering Worksheet item 7).

   or

   Map a drive to the GroupWise volume for the post office (System Clustering Worksheet item 8).

   The GroupWise volume name will be `cluster_volume`. For assistance with mapping a drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 44.

2. Create the post office directory (System Clustering Worksheet item 12).

3. In ConsoleOne, connect to the GroupWise domain where you want to create the new post office, as described in "Connecting to a Domain" in "Domains" in the Administration guide.

4. Create the new post office, following the steps provided in "Creating the New Post Office" in "Post Offices" in the Administration guide. Keep in mind the following cluster-specific details:

   - Use the Post Office Worksheet you filled out during “Planning a New Clustered Post Office” on page 20 to fill in the fields in the Create GroupWise Post Office dialog box.

   - In the Post Office Database Location field, be sure to browse through the drive you mapped in Step 1 to the post office directory you created in Step 2 above.
If you want to create a library at the post office (System Clustering Worksheet item 14), select Create Library.

After you have created the new Post Office object, display the Post Office Settings page. In the Access Mode field, select Client/Server only.

5 Click the new Post Office object > modify the POA object, following the steps provided in "Using Client/Server Access to the Post Office" in "Post Office Agent" in the Administration guide.

Refer to the Agent Clustering Worksheet that you filled in during “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on page 26 for the secondary IP address and cluster-unique port numbers that you need to provide.

On the POA Agent Settings and Scheduled Events pages, you may want to specify unique times for the following POA activities to prevent multiple POAs from running the performing the same activities on the same server during a failover situation:

- Start User Upkeep
- Generate Address Book for Remote
- Enable QuickFinder Indexing
- Mailbox/Library Maintenance Event

For more information about these repetitive POA activities, see "Performing Nightly User Upkeep", "Regulating Indexing", and "Scheduling Database Maintenance" in "Post Office Agent" in the Administration guide.

6 Use the Link Configuration tool to change the links between the new post office and its domain to TCP/IP, following the steps provided in "Using TCP/IP Links between the Post Office and the Domain" in "Post Office Agent" in the Administration guide.

7 Make sure you are still connected to the domain that owns the new post office.

8 Rebuild the post office database for the new post office, following the steps provided in "Rebuilding Domain or Post Office Databases" in "Databases" in the Administration guide. Be sure to browse to the database location through the virtual server that was created when you cluster-enabled the GroupWise volume.

The database rebuild is necessary in order to transfer the POA configuration information and the post office link information into the
post office database, because the POA for the new post office is not yet running.

If you want to create a library (System Clustering Worksheet item 14) for the clustered post office, follow the steps in "Setting Up a Basic Library" or "Setting Up a Full-Service Library" in "Libraries and Documents" in the Administration guide, after you have completely finished setting up the clustered post office.

Continue with “Installing and Configuring the MTA and the POA in a Cluster” on page 53.

Installing and Configuring the MTA and the POA in a Cluster

After you have created a new domain and/or post office, you are ready to install and configure the GroupWise agents. Complete all the tasks below if you are setting up a new GroupWise system or if you have created a new GroupWise volume where you want to install the agent software:

- “Installing the Agent Software in a Cluster” on page 54
- “Editing Clustered Agent Startup Files” on page 55
- “Configuring the GroupWise Volume Resource to Load and Unload the Agents” on page 56

Under some circumstances, the agent software has already been installed and you simply need to create a new startup file specific to the new domain or post office. For example:

- You have created a new domain and/or post office on a GroupWise volume where the agent software is already installed in the vol:/SYSTEM directory of the GroupWise volume.
- In your GroupWise system, the agent software is already installed to multiple SYS:/SYSTEM directories.

In these circumstances, follow the instructions in “Setting Up New Instances of the Agents without Installing the Agent Software” on page 62 instead of completing the tasks above.

Setting Up a Domain and Post Office in a Cluster
Installing the Agent Software in a Cluster

To install the MTA and the POA:

1. Map a drive to the GroupWise volume for the domain (Agent Clustering Worksheet item 2) or the post office (Agent Clustering Worksheet item 5).

   The GroupWise volume name will be `cluster_volume`. For assistance with mapping a drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 44.

2. If you selected `vol:\`\SYSTEM on GroupWise Volume as the agent installation location (under Agent Clustering Worksheet item 1), create the `vol:\`\SYSTEM directory on the GroupWise volume accessed in Step 1.

   or

   If you selected `SYS:\`\SYSTEM on Each Server, decide which server you will install the agents to first.

3. Start the Agent Installation program, following the steps provided in "Installing the NLM Agent Software" in "Installing GroupWise Agents" in the Installation guide.

4. Install the NLM™ agents, keeping in mind the following cluster-specific details:

   - Use the NLM Agent Clustering Worksheet that you filled out during “Planning the NLM Agent Installation in a Cluster” on page 33 to fill in the fields during the agent installation process.

   - In the Installation Path dialog box, be sure to browse through the drive you mapped in Step 1 to the location you chose in Step 2 above. Also select Configure GroupWise Agents for Clustering.

   - In the Domains / Post Offices dialog box, click Add for each domain and post office that the agents will service. In the Path to Database field, be sure to browse through the drive you mapped in Step 1 above to the domain directory or the post office directory. In the HTTP Port field, specify the cluster-unique HTTP port planned for each agent (under Agent Clustering Worksheet items 4 and 7).

   - In the Installation Complete dialog box, deselect Launch GroupWise Agents Now. You will configure the agents to launch in protected mode later.

5. If you need to install the agents to `SYS:\`\SYSTEM on multiple servers in the cluster:
5a Repeat Step 4, mapping new drives as needed.

5b If you selected Yes for Consolidate Multiple Startup Files on GroupWise Volume? (under Agent Clustering Worksheet item 1), copy one complete set of agent startup files and the GRPWISE.NCF file to the planned location, then delete all agent startup files, as well as the GRPWISE.NCF file, from the SYS\SYSTEM directories to avoid future confusion.

The GRPWISE.NCF file includes a LOAD command for each instance of each agent. You will use this information later when you create the load and unload scripts for the volume resources.

6 Continue with “Editing Clustered Agent Startup Files” on page 55.

Editing Clustered Agent Startup Files

By default, the Agent Installation program creates agent startup files in the agent installation directory. Each MTA startup file is named after the domain it services, with a .MTA extension. Each POA startup file is named after the post office it services, with a .POA extension.

Because you selected Configure GroupWise Agents for Clustering during installation, the Agent Installation program set the MTA /home switch and the POA /home switch using the format:

volume:\directory

so that the startup files are valid no matter which server the agents are currently running on.

The Agent Installation program also adds a /cluster switch to POA startup files to ensure that GroupWise clients detect the clustering environment and try more persistently to reconnect in a failover, failback, or migration situation.

One additional manual modification of POA startup files is required for robust functionality in a clustering environment. Uncomment the /ip switch and provide the secondary IP address of the GroupWise volume where the post office is located (Agent Clustering Worksheet item 7). This information is available to the POA in its NDS object properties. However, in some failover situations, reconnection to the MTA is improved when the information is immediately available to the POA in its startup file.

If you are running the POA in protected memory, add the /user and /password switches in order to provide a user name and password that the POA can use to access the volumes where its post office and, optionally, a document storage area reside.
Configuring the GroupWise Volume Resource to Load and Unload the Agents

The properties of the Volume Resource object define how the GroupWise volume functions within the cluster, how NLM programs are loaded and unloaded, and how failover and failback situations are handled. At this point, you may have one volume resource with a domain and post office on it, or you may have two volume resources, one for the domain and one for the post office. Complete the following tasks for each volume resource:

- “Modifying the Volume Resource Load Script for the Agents” on page 56
- “Modifying the Volume Resource Unload Script for the Agents” on page 58
- “Setting the Failover Path and Policies for the Agents” on page 60

Modifying the Volume Resource Load Script for the Agents

The volume resource load script executes whenever the GroupWise volume comes online.

To set up the load script:

1 In ConsoleOne, browse to and select the Cluster object.
   If necessary, click View > Console View to display its contents.
2 Right-click the Volume Resource object (cluster_SERVER) > click Properties > Load to display the default volume resource load script for the GroupWise volume.
3 Make the following changes to the default load script:
   - Remove the TRUSTMIG line. It is not necessary to migrate trustees for a GroupWise volume. Removing this line helps the load script to execute faster.
   - If you selected SLP as a short name resolution method, add the CVSBIND ADD command for the GroupWise volume to the load script.

\texttt{CVSBIND ADD cluster\_volume\_SERVER IP\_address}

- If the load script will load an MTA that needs to perform NDS user synchronization, add the command to load DSAPI.NLM. For information about NDS user synchronization, see "Using NDS User..."
Synchronization" in "Message Transfer Agent" in the Administration guide.

LOAD DSAPI.NLM

- Add the following abend recovery options:

  SET AUTO RESTART AFTER ABEND = 2
  SET AUTO RESTART AFTER ABEND DELAY TIME = 0
  SET AUTO RESTART DOWN TIMEOUT = 60
  SET DEVELOPER OPTION = OFF

  These settings provide the best possible handling of GroupWise databases in the event that an abend should occur within the cluster.

- If you selected vol:\SYSTEM on GroupWise Volume as the agent installation location (Agent Clustering Worksheet item 1), add a SEARCH ADD command to add the new vol:\SYSTEM directory to the server search path.

  SEARCH ADD volume:\\SYSTEM

- If you selected SYS:\SYSTEM on Each Server as the installation location (Agent Clustering Worksheet item 1) but you are storing the agent startup files on the GroupWise volume, add that location to the server search path.

- Transfer the agent LOAD commands from the GRPWISE.NCF file into the load script. Use Ctrl+V to paste text into the load script page. Then delete or rename the GRPWISE.NCF file to avoid future confusion.

  LOAD volume:\\SYSTEM\agent.NLM @startup_file

- If you selected Yes under Load Agents in Protected Memory? (Agent Clustering Worksheet item 8), add the ADDRESS SPACE parameter to the agent LOAD commands to specify the protected address space for each agent. Add a PROTECTION RESTART command for each address space name.

  LOAD ADDRESS SPACE=addrspacename
  volume:\\SYSTEM\agent.NLM @startup_file
  PROTECTION RESTART name

  Also add the POA /user and /password switches either in the POA startup file or on the command line in the load script.

The result would look similar to the following example:
4 Click Apply to save the load script.

5 Continue with “Modifying the Volume Resource Unload Script for the Agents” on page 58.

Modifying the Volume Resource Unload Script for the Agents

The volume resource unload script executes whenever the GroupWise volume goes offline. Programs should be unloaded in the reverse order of how they were loaded. This ensures that supporting programs are not unloaded before programs that rely on them in order to function properly.

To set up the unload script:

1 In ConsoleOne, in the properties pages for the Volume Resource object (cluster_SERVER), click Unload to display the default volume resource unload script.

2 Make the following changes to the default unload script:

   - If you selected Yes under Load Agents in Protected Memory (Agent Clustering Worksheet item 8), add an UNLOAD ADDRESS SPACE command for each address space. Add an UNLOAD KILL ADDRESS SPACE command to ensure that the address space is completely cleaned up.
UNLOAD ADDRESS SPACE=addrspacename
UNLOAD KILL ADDRESS SPACE=addrspacename

If your system seems to be trying to kill the address space before the GroupWise agents have been completely unloaded, resulting in the agents hanging in the unloading state, load the DELAY.NLM program and set a delay of several seconds before issuing the UNLOAD KILL ADDRESS SPACE command to allow the GroupWise agents adequate time to unload completely. The length of the delay varies from system to system; ten seconds is a good starting place.

UNLOAD ADDRESS SPACE=addrspacename
LOAD DELAY.NLM
DELAY 10
UNLOAD KILL ADDRESS SPACE=addrspacename

If you selected No under Load Agents in Protected Memory? (Agent Clustering Worksheet item 8), create an UNLOAD command parallel to each LOAD command that you placed in the load script.

UNLOAD volume:\directory\agent.NLM

If the load script loaded DSAPI.NLM, unload it in the unload script.

UNLOAD DSAPI.NLM

If you selected SLP as a short name resolution method, add the CVSBIND DEL command for the GroupWise volume to the unload script.

CVSBIND DEL cluster_volume_SERVER IP_address

Remove the TRUSTMIG line just like you did in the load script.

The result would look similar to the following example:
3 Click Apply to save the unload script.

4 Continue with “Setting the Failover Path and Policies for the Agents” on page 60.

Setting the Failover Path and Policies for the Agents

To modify the failover path and policies for a GroupWise volume resource:

1 In ConsoleOne, in the properties pages for the Volume Resource object (cluster_SERVER), click Nodes to display the default failover path for the GroupWise volume resource.
2 Arrange the servers in the cluster into the desired failover path for the domain or post office volume (under Agent Clustering Worksheet items 3 or 6).

3 Click Apply to save the failover path.

4 Click Policies to display the default start, failover, and failback policies.

The default policy settings are often appropriate. By default, a volume resource:

Setting Up a Domain and Post Office in a Cluster  61
Setting Up New Instances of the Agents without Installing the Agent Software

There are two steps to setting up new instances of the agents without installing the agent software:

- “Creating New Startup Files” on page 62
- “Modifying Existing Load and Unload Scripts” on page 63

Creating New Startup Files

Each MTA startup file is named after the domain it services, with a .MTA extension. Each POA startup file is named after the post office it services, with a .POA extension. If the existing agent software is located in the vol:\SYSTEM directory of a GroupWise volume, the startup files will be there as well. If the existing agent software is located in multiple SYS:\SYSTEM directories, the startup files may be located there as well or they may be in a vol:\SYSTEM directory of a GroupWise volume.

To create a new startup file without installing the agent software:

1. Make a copy of an existing startup file and name it after the domain or post office that will be serviced by the agent.

2. Edit the setting of the /home switch to point to the location of the new domain directory or post office directory. Be careful to maintain the syntax of the original line.
Scroll down through the startup file looking for other active (not commented out) startup switches > modify them as needed for the new agent.

For example, you may find that the /httpport switch is active and needs to be changed to a cluster-unique port number for the new agent.

4 Save the new startup file.

5 Continue with “Modifying Existing Load and Unload Scripts” on page 63.

Modifying Existing Load and Unload Scripts

The agent startup file names are part of the LOAD commands found in GroupWise volume resource load scripts.

If you created the new domain and/or post office on a new GroupWise volume, skip back to “Configuring the GroupWise Volume Resource to Load and Unload the Agents” on page 56 for instructions.

If you created the new domain and/or post office on an existing GroupWise volume, most of the configuration of the volume resource has already been done. You just need to add new LOAD and UNLOAD commands to the existing scripts. Continue with the steps below:

To modify existing load and unload scripts:

1 In ConsoleOne, browse to and select the Cluster object.
   If necessary, click View > Console View to display its contents.

2 Right-click the Volume Resource object (volume_SERVER) > click Properties > Load to display the volume resource load script for the GroupWise volume.

3 Following the pattern of the existing LOAD commands, add LOAD commands for the new instances of the agents you are setting up. Use Ctrl+C to copy and Ctrl+V to paste lines in the load script page.
   The results would be similar to the following example:
4 Click Apply to save the modified load script.

5 Click Scripts > Cluster Resource Unload Script.

6 Add corresponding UNLOAD commands for the new instances of the agents.
Click Apply to save the modified unload script.

You may want to review other properties of the Volume Resource object, such as the failover path on the Nodes page and the failover/failback/migration procedures on the Policies page, in light of the fact that an additional domain and/or post office now resides on the GroupWise volume.

Change other Volume Resource properties as needed.

Click OK to save the modified properties.

In the Cluster State View, take the GroupWise volume offline and then bring it online again to test the new startup files and the modified load and unload scripts. If you need assistance with these tasks, see “Testing Your Clustered GroupWise System” on page 65.

**Testing Your Clustered GroupWise System**

After you have configured the GroupWise volume resources, you can test the load and unload scripts by bringing the GroupWise volume online and taking it offline again.

To test the a GroupWise volume resource:

1. In ConsoleOne, select the Cluster object > click View > Cluster State.
The new GroupWise volume resource shows Offline in the State column.

2 Click the new GroupWise volume resource > click Online.

The State column for the volume resource now displays Running.

3 Observe the server console where the MTA and/or POA are loading to see that they start and run correctly.

If you are using protected memory, you can use the PROTECTION command at the server console prompt to list all the address spaces on the server and what NLM programs are running in each one.

4 Click the new GroupWise volume resource > click Offline.

The State column for the volume resource returns to Offline.

66 Clustering
5 Observe the server console where the MTA and/or POA are unloading to see that they shut down correctly.

If you are using protected memory, you can use the PROTECTION command again to make sure that the address spaces used by the GroupWise agents are no longer present.

6 Repeat Step 2 whenever you are ready to bring the new GroupWise volume resource online permanently.

7 Continue with “Managing Your Clustered GroupWise System” on page 67.

Managing Your Clustered GroupWise System

After you have set up a basic clustered GroupWise system, you should consider some long-term management issues.

- “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 67
- “Knowing What to Expect in MTA and POA Failover Situations” on page 69

Updating GroupWise Objects with Cluster-Specific Descriptions

After setting up your clustered GroupWise system, while the cluster-specific information is fresh in your mind, you should record that cluster-specific information as part of the GroupWise objects on ConsoleOne so that you can easily refer to it later. Be sure to keep the information recorded in the GroupWise objects up to date if the configuration of your system changes.

- “Recording Cluster-Specific Information for a Domain and Its MTA” on page 68
- “Recording Cluster-Specific Information for a Post Office and Its POA” on page 68
- “Recording Cluster-Specific Information for a Software Distribution Directory” on page 69
Recording Cluster-Specific Information for a Domain and Its MTA

To permanently record important cluster-specific information for the domain:

1. In ConsoleOne, browse to and right-click the Domain object > click Properties.

2. In the Description field of the domain Identification page, provide a cluster-specific description of the domain, including the secondary IP address of its cluster-enabled volume and the cluster-unique port numbers used by its MTA.

3. Click OK to save the domain description.

4. Select the Domain object to display its contents.

5. Right-click the MTA object > click Properties.

6. In the Description field of the MTA Identification page, record the secondary IP address of the cluster-enabled domain volume and the cluster-unique port numbers used by the MTA.

   This information will appear on the MTA console, no matter which server in the cluster it is currently running on.

7. Click OK to save the MTA description.


Recording Cluster-Specific Information for a Post Office and Its POA

To permanently record important cluster-specific information for a post office:

1. In ConsoleOne, browse to and right-click the Post Office object > click Properties.

2. In the Description field of the post office Identification page, provide a cluster-specific description of the post office, including the secondary IP address of its cluster-enabled volume and the cluster-unique port numbers used by its POA.

3. Click OK to save the post office description.

4. Select the Post Office object to display its contents.

5. Right-click the POA object > click Properties.
6 In the Description field of the POA Identification page, record the secondary IP address of the cluster-enabled post office volume and the cluster-unique port numbers used by the POA.

This information will appear on the POA console, no matter which server in the cluster it is currently running on.

7 Click OK to save the POA description.

8 If necessary, continue with “Recording Cluster-Specific Information for a Software Distribution Directory” on page 69.

or

Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 69.

Recording Cluster-Specific Information for a Software Distribution Directory

To permanently record important cluster-specific information about a software distribution directory located on a cluster-enabled volume:

1 In ConsoleOne, click Tools, System Operations > Software Directory Management.

2 Select the software distribution directory > click Edit.

3 In the description field, record the secondary IP address of the cluster-enabled volume where the software distribution directory resides.

4 Click OK > Close to save the software distribution directory description.

5 Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 69.

Knowing What to Expect in MTA and POA Failover Situations

In a failover situation, the agents may need to perform some database repair as they start on the new server. The time required depends on the size of the databases involved.

Typically, the POA returns to full functionality faster than the MTA. This benefits GroupWise client users who can reconnect to their mailboxes very quickly and probably will not notice if messages to users in other post offices are not delivered immediately. The only time a user would need to restart the GroupWise client would be if he or she was actually in the process of sending a message when the POA went down. Notify can continue running even if the...
connection to the POA becomes unavailable and then it reconnects automatically when the POA is again available.

The MTA typically takes some time reestablishing the links to its post offices, other domains, and gateways, but this situation usually resolves itself in a few minutes without administrator intervention. If it does not, you can manually restart the MTA to speed up the process.

In comparison to failover, migration typically takes longer because the agents methodically terminate their threads and close their databases as part of their normal shutdown procedure. However, as a result, no database repair is required when the agents start up again in their new location.

Continue with “Other Things You Can Do” on page 70.

Other Things You Can Do

Now that you have at least one GroupWise domain and post office up and running in a clustering environment, you are ready to proceed with the rest of your GroupWise system setup by:

- Adding users to post offices. See "Users" in the Administration guide.
- Setting up the GroupWise client software and helping users to get started using it. See "Client" in the Administration guide. See also the User's Guide.
- Connecting your clustered GroupWise system to the Internet. See Chapter 4, “Implementing the Internet Agent in a Cluster,” on page 77.
- Connecting your clustered GroupWise system to other e-mail systems through GroupWise gateways. See Chapter 6, “Implementing GroupWise Gateways in a Cluster,” on page 131.
- Monitoring the status of your clustered GroupWise system from your Web browser. See Chapter 7, “Monitoring a Clustered GroupWise System,” on page 133.
Clustering Quick Checklists

- “GroupWise System Quick Checklist” on page 71
- “Domain Quick Checklist” on page 72
- “Post Office Quick Checklist” on page 74

GroupWise System Quick Checklist

- Plan your new clustered GroupWise system.

- Cluster-enable the volumes where GroupWise domains and post offices will reside.
  See “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 44.

- Make sure that short name resolution works throughout your network.
  See “Configuring Short Name Resolution” on page 44.

- Create the primary domain and initial post office in your new clustered GroupWise system.
  See “Setting Up a New GroupWise System in a Cluster” on page 47.

- Set up the agents for the primary domain and the initial post office.
  See “Installing and Configuring the MTA and the POA in a Cluster” on page 53.

- Modify the volume resource load script(s):
  - Remove the TRUSTMIG command
  - Add the CVSBIND ADD command (optional)
  - Add the LOAD DSAPI.NLM command (optional)
  - Add the SET AUTO RESTART commands
  - Add the SET DEVELOPER OPTION = OFF command
  - Add the SEARCH ADD command (optional)
  - Add the agent LOAD command(s)
Add the ADDRESS SPACE parameter to the LOAD command(s) and add a corresponding PROTECTION RESTART command for each name space (optional)

See “Modifying the Volume Resource Load Script for the Agents” on page 56.

Modify the volume resource unload script(s):

- Add the agent or address space UNLOAD command(s)
- Add the UNLOAD DSAPI.NLM command if you loaded DSAPI.NLM in the load script
- Add the CVSBIND DEL command if you used the CVSBIND ADD command in the load script
- Remove the TRUSTMIG command

See “Modifying the Volume Resource Unload Script for the Agents” on page 58.

Set up the volume failover path(s) and policies.

See “Setting the Failover Path and Policies for the Agents” on page 60.

Test your new clustered GroupWise system.

See “Testing Your Clustered GroupWise System” on page 65.

Record cluster-specific information in the properties pages of the GroupWise objects that the information pertains to.

See “Managing Your Clustered GroupWise System” on page 67.

**Domain Quick Checklist**

- Plan your new clustered domain.
  
  See “Planning a New Clustered Domain” on page 19.

- Cluster-enable the volume where the domain will reside.
  
  See “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 44.

- Make sure that short name resolution for the new domain volume works throughout your network.
  
  See “Configuring Short Name Resolution” on page 44.

- Create the new domain.
See “Creating a New Secondary Domain in a Cluster” on page 49.

- Set up the MTA for the new domain.
  See “Installing and Configuring the MTA and the POA in a Cluster” on page 53.

- Modify the domain volume resource load script:
  - Remove the TRUSTMIG command
  - Add the CVSBIND ADD command (optional)
  - Add the LOAD DSAPI.NLM command (optional)
  - Add the SET AUTO RESTART commands
  - Add the SET DEVELOPER OPTION = OFF command
  - Add the SEARCH ADD command (optional)
  - Add the MTA LOAD command
  - Add the ADDRESS SPACE parameter to the MTA LOAD command and add a corresponding PROTECTION RESTART command for the name space (optional)
  See “Modifying the Volume Resource Load Script for the Agents” on page 56.

- Modify the domain volume resource unload script:
  - Add the MTA or address space UNLOAD command
  - Add the UNLOAD DSAPI.NLM command if you loaded DSAPI.NLM in the load script
  - Add the CVSBIND DEL command if you used the CVSBIND ADD command in the load script
  - Remove the TRUSTMIG command
  See “Modifying the Volume Resource Unload Script for the Agents” on page 58.

- Set up the domain volume failover path and policies.
  See “Setting the Failover Path and Policies for the Agents” on page 60.

- Test your new clustered domain.
  See “Testing Your Clustered GroupWise System” on page 65.
Record cluster-specific information in the properties pages of the GroupWise objects that the information pertains to.

See “Managing Your Clustered GroupWise System” on page 67.

Post Office Quick Checklist

- Plan your new clustered post office.
  See “Planning a New Clustered Post Office” on page 20.
- Cluster-enable the volume where the post office will reside.
  See “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 44.
- Make sure that short name resolution for the new post office volume works throughout your network.
  See “Configuring Short Name Resolution” on page 44.
- Create the new post office.
  See “Creating a New Post Office in a Cluster” on page 51.
- Set up the POA for the new post office.
  See “Installing and Configuring the MTA and the POA in a Cluster” on page 53.
- Add the /ip switch to the POA startup file in order to provide the secondary IP address of the post office volume.
  See “Editing Clustered Agent Startup Files” on page 55.
- Modify the post office volume resource load script:
  - Remove the TRUSTMIG command
  - Add the CVSBIND ADD command (optional)
  - Add the SET AUTO RESTART commands
  - Add the SET DEVELOPER OPTION = OFF command
  - Add the SEARCH ADD command (optional)
  - Add the POA LOAD command
  - Add the ADDRESS SPACE parameter to the POA LOAD command and add a corresponding PROTECTION RESTART command for the name space (optional)
Modify the post office volume resource unload script:
- Add the POA or address space UNLOAD command
- Add the CVSBIND DEL command if you used the CVSBIND ADD command in the load script
- Remove the TRUSTMIG command

Set up the post office volume failover path and policies.

Test your new clustered post office.

Record cluster-specific information in the properties pages of the GroupWise objects that the information pertains to.
Implementing the Internet Agent in a Cluster

You should already have set up at least a basic GroupWise system, as described in Chapter 2, “Planning GroupWise in a Clustering Environment,” on page 15 and Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43. As part of this process, the “System Clustering Worksheet” on page 35 and the “IP Address Worksheet” on page 39 were filled out. If you do not have access to the filled-out worksheets, print the worksheets now and fill in the clustering and network address information as it currently exists on your system. You will need this information as you implement the Internet Agent in a cluster.

- “Planning the Internet Agent in a Cluster” on page 77
- “Setting Up the Internet Agent in a Cluster” on page 83
- “Managing Your Clustered Internet Agent” on page 95
- “Internet Agent Clustering Worksheet” on page 98
- “Internet Agent Quick Checklist” on page 100

Planning the Internet Agent in a Cluster

A main system configuration difference between a GroupWise system in a clustering environment and a GroupWise system in a regular environment is that you need to create a separate domain to house each GroupWise gateway, including the Internet Agent.

The “Internet Agent Clustering Worksheet” on page 98 lists all the information you will need as you set up the Internet Agent in a clustering environment. You should print the worksheet and fill it out as you complete the tasks listed below:
Planning a Domain for the Internet Agent

The considerations involved in planning a domain for the Internet Agent are much the same as planning any other domain. In preparation, review "Planning a New Domain", then print and fill out the "Domain Worksheet" in "Domains" in the Administration guide.

Keep in mind the following cluster-specific details:

- When you specify the location for the domain directory on the Domain Worksheet, include the shared volume where you want the domain directory to reside.
- Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You will plan the MTA installation later.

When you have completed the Domain Worksheet, transfer the key information from the Domain Worksheet to the Internet Agent Clustering Worksheet.
Deciding Whether to Cluster-Enable the Internet Agent Volume

You should plan to cluster-enable the shared volume where the Internet Agent domain will reside. For a review of the benefits of cluster-enabling volumes, see “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21, which describes the issues in the context of planning MTA and POA installations.

Cluster-enabling relies on successful short name resolution throughout your system. Review “Ensuring Successful Name Resolution for GroupWise Volumes” on page 23, which describes the issues in the context of planning MTA and POA installations.

Determining an Appropriate Failover Path for the Internet Agent Volume

As with the MTA and the POA, you need to decide which servers in the cluster would be appropriate locations for the Internet Agent volume to fail over to. For a review of failover paths, see “Determining Appropriate Failover Paths for the Agents” on page 29, which describes the issues in the context of planning MTA and POA installations.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: Shared Volume for Internet Agent, transfer the domain location to the Internet Agent Clustering Worksheet.

Under Item 2: Internet Agent Domain Name, transfer the domain name and database directory to the Internet Agent Clustering Worksheet.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: Shared Volume for Internet Agent, mark Yes under Cluster Enabled?.

Cluster-enabling relies on successful short name resolution throughout your system. Review “Ensuring Successful Name Resolution for GroupWise Volumes” on page 23, which describes the issues in the context of planning MTA and POA installations.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 3: Internet Agent Failover Path, list the servers that you want to have in the Internet Agent volume’s failover path.
Planning a Secondary IP Address and Cluster-Unique Port Numbers for the Internet Agent and Its MTA

As with the MTA and the POA, the Internet Agent needs a secondary IP address and cluster-unique port numbers. As part of planning to install the MTA and POA, you should already have determined the secondary IP address and cluster-unique port numbers for the Internet Agent and its MTA as you filled out the “IP Address Worksheet” on page 39. If you do not have a filled-out copy of this worksheet for your system, print it now and fill in current system information.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 5: MTA Network Information, transfer the MTA secondary IP address and cluster-unique port numbers from the IP Address Worksheet to the Internet Agent Clustering Worksheet.

Under Item 1: Shared Volume for Internet Agent, copy the MTA secondary IP address under Cluster Volume IP Address, because they are the same.

Under Item 7: Internet Agent Network Information, transfer the Internet Agent secondary IP address (the same as for its MTA) and the cluster-unique Internet Agent port number from the IP Address Worksheet to the Internet Agent Clustering Worksheet.

Preparing Your Firewall for the Internet Agent

The Internet Agent will receive incoming messages on the secondary IP address of the Internet Agent domain volume. Your firewall configuration must be modified to allow inbound TCP/IP traffic from the Internet to the Internet Agent secondary IP address on the following standard ports:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Standard Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMAP4</td>
<td>143</td>
</tr>
<tr>
<td>LDAP</td>
<td>389</td>
</tr>
<tr>
<td>POP3</td>
<td>110</td>
</tr>
<tr>
<td>SMTP</td>
<td>25</td>
</tr>
</tbody>
</table>
The Internet Agent will send outgoing messages on the primary IP address of the server where it is running. Therefore, your firewall must allow outbound TCP/IP traffic from all servers in the Internet Agent volume’s failover path.

If the Internet Agent has a large number of servers on its failover path, you can configure the Internet Agent to send outgoing messages to a relay host, which would then send them out through the firewall using its own IP address rather than the address of the server where the Internet Agent was running. This reduces the amount of modification to your firewall required to set up the Internet Agent. However, if the relay host goes down, outgoing messages would be delayed.

In preparation for installing the Internet Agent, configure your firewall as needed to handle the Internet Agent’s use of primary and secondary IP addresses when sending and receiving messages.

Deciding Where to Install the Internet Agent and Its MTA

As with the MTA and the POA, you can choose to install the Internet Agent and its MTA to the SYS\SYSTEM directory of each clustered server or to a vol\SYSTEM directory on the Internet Agent volume. For a discussion of these alternatives, see “Deciding Where to Install the Agent Software” on page 30, which describes the issues in the context of planning MTA and POA installations. If you only have one Internet Agent for your GroupWise system with several servers in its failover path, it is an easy choice.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 4: MTA Installation Location and Item 6: Internet Agent Installation Location, mark whether you will install the Internet Agent and its MTA to a vol\SYSTEM directory on the Internet Agent volume or to SYS\SYSTEM on each server in the cluster. If necessary, specify where the MTA startup file and the Internet Agent configuration file will be stored.

Deciding Whether to Run the Internet Agent and Its MTA in Protected Memory

As with the MTA and the POA, you can choose whether to run the Internet Agent in protected memory. For a review of the benefits of protected memory, see “Deciding Whether to Run the Agents in Protected Memory” on page 32, which describes the issues in the context of planning MTA and POA installations.

Implementing the Internet Agent in a Cluster
You might think that protected memory would not be necessary if you have only one Internet Agent for your GroupWise system because it could never fail over to a server where another Internet Agent was running. However, because the Internet Agent in a cluster is installed into its own domain with its own MTA, this MTA could fail over to a server where another MTA was already running. Therefore, it is safest to load the Internet Agent and its MTA into protected memory.

Load the Internet Agent and its MTA into the same address space. They cannot communicate properly if one runs in protected memory and the other does not.

### INTERNET AGENT CLUSTERING WORKSHEET

Under Item 8: Load Internet Agent and Its MTA in Protected Memory, mark whether or not you need to run the Internet Agent and its MTA in protected memory. If you do, provide a protected memory space name.

---

**Planning the MTA Installation in a Cluster**

Follow the instructions in "Planning the NLM Agent Installation in a Cluster" on page 33, then return to this point. After you follow the instructions, you will have a filled-out NLM Agent Worksheet to use when you install the MTA.

**IMPORTANT**: Do not install the NLM MTA until you are instructed to do so in "Setting Up the Internet Agent in a Cluster" on page 83.

---

**Planning the Internet Agent Installation in a Cluster**

Aside from the cluster-specific issues discussed in the preceding sections, the considerations involved in planning to install the Internet Agent are the same in a clustering environment as for any other environment. Review the installation instructions in "Setting Up the Internet Agent NLM" in "Installing the GroupWise Internet Agent" in the Installation guide. You may want to print this section and fill in the types of planning information you have provided on worksheets in other sections. You will need this information as you install the Internet Agent in your cluster.

**IMPORTANT**: Do not install the Internet Agent software until you are instructed to do so in "Setting Up the Internet Agent in a Cluster" on page 83.
Setting Up the Internet Agent in a Cluster

You should already have reviewed “Planning the Internet Agent in a Cluster” on page 77 and filled out the “Internet Agent Clustering Worksheet” on page 98. You are now ready to complete the following tasks to set up the Internet Agent in a clustering environment:

- “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 110
- “Creating a Domain for the Internet Agent” on page 84
- “Installing the MTA for the Internet Agent Domain” on page 84
- “Installing and Configuring the Internet Agent in a Cluster” on page 84
- “Testing the Clustered Internet Agent” on page 94

Cluster-Enabling a Shared Volume for Use with the Internet Agent

To cluster-enable the Internet Agent shared volume:

1. Complete the steps in "Cluster-Enable Volumes " in "Setting Up NetWare Cluster Services" in NetWare Cluster Services Overview and Installation. Keep in mind these GroupWise-specific details:
   - In Step 3 in "Cluster-Enable Volumes ," use the shared volume from Internet Agent Clustering Worksheet item 1.
   - In Step 4 in "Cluster-Enable Volumes ," use the cluster volume IP address from Internet Agent Clustering Worksheet item 1.
   - In Step 5 in "Cluster-Enable Volumes ," use the volume failover path from Internet Agent Clustering Worksheet item 3.

2. For a review of the new NDS objects that are created when you cluster-enable a shared volume, see “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21.

3. To ensure successful short name resolution, add entries for the Internet Agent virtual server to support your preferred methods of short name resolution, as described in “Configuring Short Name Resolution” on page 44.

4. To ensure that the Internet Agent has incoming and outgoing access to the Internet, make sure your firewall is properly configured, as described in “Preparing Your Firewall for the Internet Agent” on page 80.

5. Continue with “Creating a Domain for the Internet Agent” on page 84.
Creating a Domain for the Internet Agent

The Internet Agent domain will be a secondary domain. To create it, follow the instructions in “Creating a New Secondary Domain in a Cluster” on page 49, taking your information from the Internet Agent Clustering Worksheet, rather than the System Clustering Worksheet, then return to this point.

Do not create any post offices in the Internet Agent domain.

Continue with “Installing the MTA for the Internet Agent Domain” on page 84.

Installing the MTA for the Internet Agent Domain

The MTA for the Internet Agent domain can be installed just like any other MTA in your clustered GroupWise system. Follow the instructions in “Installing the Agent Software in a Cluster” on page 54, then return to this point.

You do not need to edit the MTA startup file. You do not need to modify the Volume Resource properties until after you have installed the Internet Agent.

Continue with “Installing and Configuring the Internet Agent in a Cluster” on page 84.

Installing and Configuring the Internet Agent in a Cluster

After you have created a domain for the Internet Agent and installed the MTA for that domain, you are ready to install and configure the Internet Agent.

- “Installing the Internet Agent Software in a Cluster” on page 85
- “Configuring the Internet Agent Volume Resource to Load and Unload the Internet Agent and Its MTA” on page 86
- “Enabling Internet Addressing for Your Clustered GroupWise System” on page 92
- “Verifying GWIA Object Properties” on page 92
Installing the Internet Agent Software in a Cluster

To install the Internet Agent:

1 Map a drive to the Internet Agent volume (Internet Agent Clustering Worksheet item 1).

The Internet Agent volume name will be `cluster_volume`. For assistance with mapping a drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 44.

2 If you selected `vol:\SYSTEM` on Internet Agent Volume as the Internet Agent installation location (Internet Agent Clustering Worksheet item 6), create the `vol:\SYSTEM` directory on the Internet Agent volume accessed in Step 1.

or

If you selected `SYS:\SYSTEM` on Each Server, decide which server you will install the Internet Agent to first > map a drive to `SYS:\SYSTEM` on that server.

3 Start the Internet Agent Installation program and install the NLM™ Internet Agent, following the steps provided in "Installing the Internet Agent NLM Software" in "Installing the GroupWise Internet Agent" in the Installation guide. Keep in mind the following cluster-specific details:

- Use the notes you made during “Planning the Internet Agent Installation in a Cluster” on page 82 to fill in the fields during the Internet Agent installation process.

- In the Installation Path dialog box, be sure to browse through the drive you mapped to the location you chose in Step 2 above. Deselect Update AUTOEXEC File and select Configure GroupWise Agents for Clustering.

- In the GroupWise Domain dialog box, be sure to browse through the drive you mapped in Step 1 to the domain directory (Internet Agent Clustering Worksheet item 2).

- The GWIA Installation program creates the GWIA.NCF file, which includes the LOAD command for the Internet Agent. You will use this information later when you create the load script for the Volume Resource object.

4 If you need to install the Internet Agent to `SYS:\SYSTEM` on multiple servers in the cluster, repeat Step 4, mapping new drives as needed.
If you selected Yes for Consolidate Multiple Configuration Files on Internet Agent Volume? (under Internet Agent Clustering Worksheet item 6), copy the GWIA.CFG file to the planned location, then delete it from the SYS:\SYSTEM directories to avoid future confusion.

5 Make sure you have completed all the tasks described in "Setting Up the Internet Agent NLM" in "Installing the GroupWise Internet Agent" in the Installation guide, but do not start the Internet Agent at this time.

6 Continue with “Configuring the Internet Agent Volume Resource to Load and Unload the Internet Agent and Its MTA” on page 86.

Configuring the Internet Agent Volume Resource to Load and Unload the Internet Agent and Its MTA

The properties of the Volume Resource object define how the Internet Agent volume functions within the cluster, how NLM programs are loaded and unloaded, and how failover and failback situations are handled. Complete the following tasks for the Internet Agent volume:

- “Modifying the Volume Resource Load Script for the Internet Agent” on page 86
- “Modifying the Volume Resource Unload Script for the Internet Agent” on page 89
- “Setting the Failover Path and Policies for the Internet Agent” on page 90

Modifying the Volume Resource Load Script for the Internet Agent

The volume resource load script executes whenever the Internet Agent volume comes online.

To set up the load script:

1 In ConsoleOne™, browse to and select the Cluster object. 
   If necessary, click View > Console View to display its contents.

2 Right-click the Volume Resource object (volume_SERVER) > click Properties > Load to display the default volume resource load script for the Internet Agent volume.

   The next step assumes that this is the first time you have edited this load script. If other GroupWise agents are already running from this volume, some of the modifications will already have been made.

3 Make the following changes to the default load script:
Remove the TRUSTMIG line. It is not necessary to migrate trustees for the Internet Agent volume. Removing this line helps the load script to execute faster.

If you are using SLP as a short name resolution method, as described in “Configuring Short Name Resolution” on page 44, add the CVSBIND ADD command for the Internet Agent volume to the load script.

CVSBIND ADD cluster_volume_SERVER IP_address

Add the following abend recovery options:

SET AUTO RESTART AFTER ABEND = 2
SET AUTO RESTART AFTER ABEND DELAY TIME = 0
SET AUTO RESTART DOWN TIMEOUT = 60
SET DEVELOPER OPTION = OFF

These settings provide the best possible handling of GroupWise databases in the event that an abend should occur within the cluster.

If you selected vol:\SYSTEM on Internet Agent Volume as the installation location (Internet Agent Clustering Worksheet items 4 and 6), add a SEARCH ADD command to add the new vol:\SYSTEM directory to the server search path.

SEARCH ADD volume:\SYSTEM

If you selected SYS:\SYSTEM on Each Server as the installation location (Internet Agent Clustering Worksheet items 4 and 6) but you are storing the MTA startup file and the Internet Agent configuration file on the Internet Agent volume, add that location to the server search path.

Transfer the MTA LOAD command from the GRPWISE.NCF file located in the vol:\SYSTEM directory into the load script. Use Ctrl+C and Ctrl+V to copy and paste text into the load script page. Then delete or rename the GRPWISE.NCF file to avoid future confusion.

LOAD volume:\SYSTEM\GWMTA.NLM @domain.MTA

Add a delay so that the MTA is fully loaded before the Internet Agent starts to load:

LOAD DELAY.NLM
DELAY 10
The length of the delay varies from system to system; ten seconds is a good starting place.

- Transfer the Internet Agent LOAD command from the GWIA.NCF file located in the vol:\SYSTEM directory into the load script. Use Ctrl+C and Ctrl+V to copy and paste text into the load script page. Then delete or rename the GWIA.NCF file to avoid future confusion.

```
LOAD volume:\SYSTEM\GWIA.NLM @GWIA.CFG
```

- If you selected Yes under Load Internet Agent and Its MTA in Protected Memory? (Internet Agent Clustering Worksheet item 8), add the ADDRESS SPACE parameter to the LOAD commands to specify the protected address space where the Internet Agent and its MTA will run. Add a PROTECTION RESTART command for the address space name.

```
LOAD ADDRESS SPACE=addrspacename
    volume:\SYSTEM\GWMTA.NLM @domain.MTA
LOAD ADDRESS SPACE=addrspacename
    volume:\SYSTEM\GWIA.NLM @GWIA.CFG
PROTECTION RESTART addrspacename
```

The result would look similar to the following example:
4 Click Apply to save the load script.

5 Continue with “Modifying the Volume Resource Unload Script for the Internet Agent” on page 89.

Modifying the Volume Resource Unload Script for the Internet Agent

The volume resource unload script executes whenever the Internet Agent volume goes offline. Programs should be unloaded in the reverse order of how they were loaded. This ensures that supporting programs are not unloaded before programs that rely on them in order to function properly.

To set up the unload script:

1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), click Unload to display the default volume resource unload script.

The next step assumes that this is the first time you have edited this unload script. If other GroupWise agents are already running from this volume, some of the modifications will already have been made.

2 Make the following changes to the default unload script:

- If you selected Yes under Load Internet Agent and Its MTA in Protected Memory (Internet Agent Clustering Worksheet item 8), add an UNLOAD ADDRESS SPACE command and an UNLOAD KILL ADDRESS SPACE command to ensure that the address space is completely cleaned up.

  UNLOAD ADDRESS SPACE=addrspacename
  UNLOAD KILL ADDRESS SPACE=addrspacename

  If your system seems to be trying to kill the address space before the Internet Agent and its MTA have been completely unloaded, resulting in the agents hanging in the unloading state, set a delay of several seconds before issuing the UNLOAD KILL ADDRESS SPACE command to allow the Internet Agent and its MTA adequate time to unload completely. The length of the delay varies from system to system; ten seconds is a good starting place.

  UNLOAD ADDRESS SPACE=addrspacename
  DELAY 10
  UNLOAD KILL ADDRESS SPACE=addrspacename

- If you selected No under Load Internet Agent and Its MTA in Protected Memory? (Internet Agent Clustering Worksheet items 8),
create an UNLOAD command parallel to each LOAD command that you placed in the load script.

UNLOAD volume: \SYSTEM\GWIA.NLM  
UNLOAD volume: \SYSTEM\GWMTA.NLM

- If you are using SLP as a short name resolution method, add the CVSBIND DEL command for the Internet Agent volume to the unload script.

CVSBIND DEL cluster_volume_SERVER IP_address

- Remove the TRUSTMIG line just like you did in the load script.

The result would look similar to the following example:

![Image of properties of a volume]

3 Click Apply to save the unload script.

4 Continue with “Setting the Failover Path and Policies for the Internet Agent” on page 90.

Setting the Failover Path and Policies for the Internet Agent

To modify the failover path and policies for the Internet Agent volume resource:

90 Clustering
1. In ConsoleOne, in the properties pages for the Volume Resource object (`volume_SERVER`), click Nodes to display the default failover path for the Internet Agent volume resource.

2. Arrange the servers in the cluster into the desired failover path for the Internet Agent volume (Internet Agent Clustering Worksheet item 3).

3. Click Apply to save the failover path.

4. Click Policies to display the default start, failover, and failback policies.
The default policy settings are often appropriate. By default, a volume resource:

- Fails over automatically if the server it is running on fails
- Starts automatically on the next server in its failover path
- Continues running at its failover location, even after its most preferred server is again available

If you are considering changing these defaults, see "Set Start, Failover, and Failback Modes in "Installation and Setup" in NetWare Cluster Services Overview and Installation."

5 Click OK when you are finished editing the Internet Agent volume resource properties.

6 Continue with “Enabling Internet Addressing for Your Clustered GroupWise System” on page 92.

**Enabling Internet Addressing for Your Clustered GroupWise System**

Setting up Internet addressing for a clustered Internet Agent is no different from setting it up for an Internet Agent in any other environment. Follow the instructions in "Enabling Internet Addressing" in "System" in the Administration guide, then return to this point.

**Verifying GWIA Object Properties**

During installation of the Internet Agent, the GWIA object should have been configured correctly. However, it can be helpful to verify certain cluster-specific information in order to familiarize yourself with the configuration of a clustered Internet Agent.

- “Accessing GWIA Object Properties” on page 92
- “Verifying the Reference to the Volume Resource” on page 93
- “Verifying the Reference to the Virtual Server” on page 93
- “Verifying Post Office Links” on page 93

**Accessing GWIA Object Properties**

To access GWIA object properties:

1 In ConsoleOne, browse to and select the Internet Agent domain in order to display its contents.
2 Right-click the GWIA object > click Properties.

3 Continue with “Verifying the Reference to the Volume Resource” on page 93.

**Verifying the Reference to the Volume Resource**

In the GWIA object properties pages:

1 Click SMTP/MIME > Settings.

2 Verify the contents of the Hostname/DNS "A Record" Name field.

   It displays the hostname as currently configured in DNS. It should match the Volume Resource object name (volume_SERVER) of the Internet Agent volume, not the name of a physical server in the cluster.

3 Make changes if necessary.

4 Continue with “Verifying the Reference to the Virtual Server” on page 93.

**Verifying the Reference to the Virtual Server**

In the GWIA object properties pages:

1 Click Server Directories.

2 Verify that the displayed directories match the virtual server name (cluster_volume_SERVER) associated with the Volume Resource object, not the name of a physical server in the cluster.

3 Make changes if necessary.

4 Continue with “Verifying Post Office Links” on page 93.

**Verifying Post Office Links**

In the GWIA object properties pages:

1 Click Post Office Links.

2 Verify that the Access Mode column displays C/S (for client/server mode) for all post offices serviced by the Internet Agent.

3 Verify that the Links column displays the secondary IP addresses of the GroupWise volumes where post offices reside, not the IP addresses of any physical servers in the cluster.

4 Make changes if necessary.

5 Continue with “Testing the Clustered Internet Agent” on page 94.
Testing the Clustered Internet Agent

After you have configured the Internet Agent volume resource, you can test the load and unload scripts by bringing the Internet Agent volume online and taking it offline again.

To test the Internet Agent volume resource:

1. In ConsoleOne, select the Cluster object > click View > Cluster State.

   ![Cluster State](image)

   The new Internet Agent volume resource shows Offline in the State column.

2. Click the new Internet Agent volume resource > click Online.

   ![Cluster State](image)

   The State column for the volume resource now displays Running.
3 Observe the server console where the Internet Agent and its MTA are loading to see that they start and run correctly.

If you are using protected memory, you can use the PROTECTION command at the server console prompt to list all the address spaces on the server and what NLM programs are running in each one.

4 Click the new Internet Agent volume resource > click Offline.

The State column for the volume resource returns to Offline.

5 Observe the server console where the Internet Agent and its MTA are unloading to see that they shut down correctly.

If you are using protected memory, you can use the PROTECTION command again to make sure that the address space used by the Internet Agent and its MTA is no longer present.

6 Repeat Step 2 whenever you are ready to bring the new Internet Agent volume resource online permanently.

Managing Your Clustered Internet Agent

After you have installed the Internet Agent in a cluster, you should consider some long-term management issues.

- “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 95
- “Knowing What to Expect in an Internet Agent Failover Situation” on page 97.

Updating GroupWise Objects with Cluster-Specific Descriptions

After installing the Internet Agent in your clustered GroupWise system, while the cluster-specific information is fresh in your mind, you should record that cluster-specific information as part of the GroupWise objects in ConsoleOne so that you can easily refer to it later. Be sure to update the information recorded in the GroupWise objects if the configuration of your system changes.

- “Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA” on page 96
- “Recording Cluster-Specific Information about the Internet Agent” on page 96
Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA

To permanently record important cluster-specific information for the Internet Agent domain:

1. In ConsoleOne, browse to and right-click the Domain object > click Properties.

2. In the Description field of the Internet Agent domain Identification page, provide a cluster-specific description of the Internet Agent domain, including the secondary IP address of its cluster-enabled volume and the cluster-unique port numbers used by its MTA.

3. Click OK to save the Internet Agent domain description.

4. Select the Internet Agent Domain object to display its contents.

5. Right-click the MTA object > click Properties.

6. In the Description field of the MTA Identification page, record the secondary IP address of the cluster-enabled Internet Agent domain volume and the cluster-unique port numbers used by the MTA.

   This information will appear on the MTA console, no matter which server in the cluster it is currently running on.

7. Click OK to save the MTA description.

8. Continue with “Recording Cluster-Specific Information about the Internet Agent” on page 96.

Recording Cluster-Specific Information about the Internet Agent

With the contents of the Internet Agent domain still displayed,

1. Right-click the GWIA object > click Properties.

2. Click GroupWise > Identification.

3. In the Description field, record the secondary IP address of the cluster-enabled Internet Agent domain volume and the cluster-unique port numbers used by the Internet Agent.

   This information will appear on the Internet Agent console, no matter which server in the cluster it is currently running on.

4. Click OK to save the Internet Agent information.

5. Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 69.
Knowing What to Expect in an Internet Agent Failover Situation

The failover behavior of the MTA for the Internet Agent domain will be the same as for an MTA in a regular domain. See “Knowing What to Expect in MTA and POA Failover Situations” on page 69.

Failover of the Internet Agent itself is more complex. The various clients (POP3, IMAP4, and LDAP) will receive an error message that the server is not available. Most of the clients do not attempt to reconnect automatically, so the user must exit the GroupWise client and restart it to reestablish the connections after the failover process is complete. Fortunately, the Internet Agent restarts quickly in its failover location so users will be able to reconnect quickly.

As with the MTA and the POA, migration of the Internet Agent takes longer than failover. In fact, the Internet Agent can seem especially slow to shut down properly, as it finishes its normal processing and stops its threads. For a busy Internet Agent, you may need to wait several minutes for it to shut down properly.
# Internet Agent Clustering Worksheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Shared Volume for Internet Agent: Cluster Enabled?</td>
<td>Specify the name (<em>cluster_volume</em>) of the shared volume where the Internet Agent domain will be created.</td>
</tr>
<tr>
<td>• Yes (highly recommended)</td>
<td>For cluster-enabling, specify the IP addresses of the virtual server (<em>volume_SERVER.cluster</em>) to which the cluster-enabled volume is tied.</td>
</tr>
<tr>
<td>• No</td>
<td>For more information, see “Deciding Whether to Cluster-Enable the Internet Agent Volume” on page 79.</td>
</tr>
<tr>
<td>2) Internet Agent Domain Name: Domain Database Location:</td>
<td>Specify a unique name for the Internet Agent domain. Specify the directory on the Internet Agent volume where you want to create the new domain.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Planning a Domain for the Internet Agent” on page 78.</td>
</tr>
<tr>
<td>3) Internet Agent Failover Path:</td>
<td>List other servers in the cluster where the Internet Agent and its MTA could fail over.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Determining an Appropriate Failover Path for the Internet Agent Volume” on page 79.</td>
</tr>
<tr>
<td>4) MTA Installation Location:</td>
<td>Mark the location where you will install the MTA software. If necessary, specify the location where you will consolidate multiple MTA startup files on an Internet Agent volume.</td>
</tr>
<tr>
<td>• <code>vol:\SYSTEM</code> on Internet Agent volume</td>
<td>For more information, see “Deciding Where to Install the Internet Agent and Its MTA” on page 81.</td>
</tr>
<tr>
<td>• <code>SYS:\SYSTEM</code> on each server</td>
<td>Consolidate multiple MTA startup files on Internet Agent volume?</td>
</tr>
</tbody>
</table>
## Item 5) MTA Network Information:
- MTA IP address
- MTA message transfer port
- MTA live remote port
- MTA HTTP port

Gather the MTA network address information from the "IP Address Worksheet" on page 39. For more information, see "Planning a Secondary IP Address and Cluster-Unique Port Numbers for the Internet Agent and Its MTA" on page 80.

## Item 6) Internet Agent Installation Location:
- `vol:\SYSTEM` on Internet Agent volume
- `SYS:\SYSTEM` on each server

Consolidate multiple Internet Agent configuration files on Internet Agent volume?

Mark the location where you will install the Internet Agent software. If necessary, specify the location where you will consolidate multiple Internet Agent configuration files (GWIA.CFG) on an Internet Agent volume. For more information, see "Deciding Where to Install the Internet Agent and Its MTA" on page 81.

## Item 7) Internet Agent Network Information:
- Internet Agent IP address
- Internet Agent HTTP port

Gather the Internet Agent network address information from the "IP Address Worksheet" on page 39. For more information, see "Planning a Secondary IP Address and Cluster-Unique Port Numbers for the Internet Agent and Its MTA" on page 80.

## Item 8) Load Internet Agent and Its MTA in Protected Memory?
- No
- Yes

Protected address space

Mark whether you need to run the Internet Agent and its MTA in protected memory. If so, specify a unique address space. For more information, see "Deciding Whether to Run the Internet Agent and Its MTA in Protected Memory" on page 81.
Internet Agent Quick Checklist

- Plan the new clustered Internet Agent, including the new domain required to house the Internet Agent in a clustering environment.
  See “Planning the Internet Agent in a Cluster” on page 77.
- Make sure your firewall is configured to accommodate the Internet Agent.
  See “Preparing Your Firewall for the Internet Agent” on page 80.
- Cluster-enable the volume where the Internet Agent domain will reside.
  See “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 110.
- Create the new Internet Agent domain.
  See “Creating a Domain for the Internet Agent” on page 84.
- Set up the MTA for the new Internet Agent domain.
  See “Installing the MTA for the Internet Agent Domain” on page 84.
- Install the Internet Agent.
  See “Installing the Internet Agent Software in a Cluster” on page 85.
- Modify the Internet Agent volume resource load script:
  - Remove the TRUSTMIG command
  - Add the CVSBIND ADD command (optional)
  - Add the SET AUTO RESTART commands
  - Add the SET DEVELOPER OPTION = OFF command
  - Add the SEARCH ADD command (optional)
  - Add the LOAD commands for the MTA and the Internet Agent, separating them with a DELAY command
  - Add the ADDRESS SPACE parameter to the LOAD commands and add a PROTECTION RESTART command for the name space (optional)
  See “Modifying the Volume Resource Load Script for the Internet Agent” on page 86.
- Modify the Internet Agent volume resource unload script:
Add the MTA and Internet Agent or address space UNLOAD command(s)

Add the CVSBIND DEL command if you used the CVSBIND ADD command in the load script

Remove the TRUSTMIG command

See “Modifying the Volume Resource Unload Script for the Internet Agent” on page 89.

Set up the Internet Agent volume failover path and policies.

See “Setting the Failover Path and Policies for the Internet Agent” on page 90.

Enable Internet Addressing for the clustered Internet Agent.

See “Enabling Internet Addressing for Your Clustered GroupWise System” on page 92.

Double-check the cluster-specific GWIA object properties.

See “Verifying GWIA Object Properties” on page 92.

Test the clustered Internet Agent.

See “Testing the Clustered Internet Agent” on page 94.

Record cluster-specific information in the properties pages of the GroupWise objects associated with the Internet Agent.

See “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 95.
Implementing WebAccess in a Cluster

You should already have set up at least a basic GroupWise® system, as described in Chapter 2, “Planning GroupWise in a Clustering Environment,” on page 15 and Chapter 3, “Setting Up a Domain and Post Office in a Cluster,” on page 43. As part of this process, the “System Clustering Worksheet” on page 35 and the “IP Address Worksheet” on page 39 were filled out. If you do not have access to the filled-out worksheets, print the worksheets now and fill in the clustering and network address information as it currently exists on your system. You will need this information as you implement WebAccess in a cluster.

- “Understanding the WebAccess Components” on page 103
- “Planning WebAccess in a Cluster” on page 104
- “Setting Up WebAccess in a Cluster” on page 110
- “Managing WebAccess in a Cluster” on page 122
- “WebAccess Clustering Worksheet” on page 126
- “WebAccess Quick Checklist” on page 129

Understanding the WebAccess Components

If you are not familiar with GroupWise WebAccess, review "GroupWise WebAccess Component Overview" in "Installing GroupWise WebAccess" in the Installation guide.

As you plan WebAccess in a clustering environment, you must keep in mind that you will plan and set up two WebAccess components:

- WebAccess Agent (GWINTER.NLM) that will be associated with a GroupWise WebAccess domain
- WebAccess Application (a Java® servlet) that will be added to your Web server (Netscape® Enterprise Server® for NetWare® required)
Planning WebAccess in a Cluster

A main system configuration difference between a GroupWise system in a clustering environment and a GroupWise system in a regular environment is that you need to create a separate domain to house each GroupWise gateway, including the WebAccess Agent.

The “WebAccess Clustering Worksheet” on page 126 lists all the information you will need as you set up the WebAccess Agent and the WebAccess Application in a clustering environment. You should print the worksheet and fill it out as you complete the tasks listed below:

- “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster” on page 104
- “Planning a New Domain for the WebAccess Agent” on page 105
- “Deciding Whether to Cluster-Enable the WebAccess Agent Volume” on page 106
- “Determining an Appropriate Failover Path for the WebAccess Agent Volume” on page 106
- “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on page 107
- “Deciding Where to Install the WebAccess Agent and Its MTA” on page 107
- “Deciding Whether to Run the WebAccess Agent and Its MTA in Protected Memory” on page 108
- “Planning the MTA Installation in a Cluster” on page 108
- “Planning the WebAccess Installation in a Cluster” on page 108

Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster

Although several Web servers are supported for use with GroupWise WebAccess in a non-clustered environment, only the Netscape Enterprise Server for NetWare is supported in a clustering environment because it is the only currently supported Web server that runs on NetWare. In preparation for installing WebAccess in your clustered GroupWise system, install and set up the Netscape Enterprise Server for NetWare, following the instructions in "Configuring Netscape Enterprise Server with NetWare Cluster Services" in NetWare Cluster Services Resource Configuration Guide.
As you set up the Netscape Enterprise Server, record the following key configuration information on the WebAccess Clustering Worksheet:

WEBACCESS CLUSTERING WORKSHEET

Under **Item 10: Physical Web Servers**, list the physical NetWare servers where you are installing the Netscape Enterprise Server software.

Under **Item 11: Netscape Enterprise Server IP Address**, record the secondary IP address of the Netscape Enterprise Server cluster resource that you create.

Under **Item 12: Netscape Enterprise Server Mode**, mark whether you have configured the Netscape Enterprise Server to run in active/active or active/passive mode. In active/active mode, the Netscape Enterprise Server runs on multiple servers simultaneously; this is the recommended mode.

Under **Item 13: Netscape Enterprise Server Failover Path**, list the servers in the cluster where you want the Netscape Enterprise Server cluster resource to fail over.

Under **Item 14: Hardware Virtual Server Information**, record the dedicated IP address for the Web site and the document root directory.

The Netscape Enterprise Server for NetWare does not depend on the functionality of cluster-enabled volumes the way GroupWise does. Because the WebAccess Application will be installed to a subdirectory of the Netscape Enterprise Server installation directory (SYS:\NOVONYX\SUITE\DOCS\COM\NOVELL\WEBACCESS), the WebAccess Application cannot be installed on a cluster-enabled volume. Instead, it will be installed to the SYS: volume on each server where the Netscape Enterprise Server has been installed.

**Planning a New Domain for the WebAccess Agent**

The considerations involved in planning a domain for the WebAccess Agent are much the same as planning any other domain. In preparation, review "Planning a New Domain", then print and fill out the "Domain Worksheet" in "Domains" in the Administration guide.

Keep in mind the following cluster-specific details:

- When you specify the location for the domain directory on the Domain Worksheet, include the shared volume where you want the domain directory to reside.

- Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You will plan the MTA installation later.
When you have completed the Domain Worksheet, transfer the key information from the Domain Worksheet to the WebAccess Clustering Worksheet.

**WEBACCESS CLUSTERING WORKSHEET**

Under Item 1: Shared Volume for WebAccess Agent, transfer the domain location from the Domain Worksheet to the WebAccess Clustering Worksheet.

Under Item 2: WebAccess Agent Domain Name, transfer the domain name and database directory from the Domain Worksheet to the WebAccess Clustering Worksheet.

### Deciding Whether to Cluster-Enable the WebAccess Agent Volume

You should plan to cluster-enable the shared volume where the WebAccess Agent domain will reside. For a review of the benefits of cluster-enabling volumes, see “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21, which describes the issues in the context of planning MTA and POA installations.

**WEBACCESS CLUSTERING WORKSHEET**

Under Item 1: Shared Volume for WebAccess Agent, mark Yes under Cluster Enabled?.

Cluster-enabling relies on successful short name resolution throughout your system. Review “Ensuring Successful Name Resolution for GroupWise Volumes” on page 23, which describes the issues in the context of planning MTA and POA installations.

### Determining an Appropriate Failover Path for the WebAccess Agent Volume

As with the MTA and the POA, you need to decide which servers in the cluster would be appropriate locations where the WebAccess Agent volume could fail over. For a review of failover paths, see “Determining Appropriate Failover Paths for the Agents” on page 29, which describes the issues in the context of planning MTA and POA installations.

**WEBACCESS CLUSTERING WORKSHEET**

Under Item 4: WebAccess Agent Failover Path, list the servers that you want to have in the WebAccess Agent volume’s failover path.
Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA

As with the MTA and the POA, the WebAccess Agent needs a secondary IP address and cluster-unique port numbers. As part of planning to install the MTA and POA, you should already have determined the secondary IP address and cluster-unique port numbers for the WebAccess Agent and its MTA as you filled out the “IP Address Worksheet” on page 39. If you do not have a filled-out copy of this worksheet for your system, print it now and fill in current system information.

WEBACCESS CLUSTERING WORKSHEET

Under Item 6: MTA Network Information, transfer the MTA secondary IP address and cluster-unique port numbers from the IP Address Worksheet to the WebAccess Clustering Worksheet.

Under Item 1: Shared Volume for WebAccess Agent, copy the MTA secondary IP address under Cluster Volume IP Address as well.

Under Item 8: WebAccess Agent Network Information, transfer the WebAccess Agent secondary IP address (the same as for its MTA) and the cluster-unique WebAccess Agent port number from the IP Address Worksheet to the WebAccess Clustering Worksheet.

Deciding Where to Install the WebAccess Agent and Its MTA

As with the MTA and the POA, you can choose to install the WebAccess Agent and its MTA to the SYS:\SYSTEM directory of each clustered server or to a vol:\SYSTEM directory on the WebAccess Agent volume. For a discussion of these alternatives, see “Deciding Where to Install the Agent Software” on page 30, which describes the issues in the context of planning MTA and POA installations. If you only have one WebAccess Agent for your GroupWise system with several servers in its failover path, it is an easy choice.

WEBACCESS CLUSTERING WORKSHEET

Under Item 5: MTA Installation Location and Item 7: WebAccess Agent Installation Location, mark whether you will install the WebAccess Agent and its MTA to SYS:\SYSTEM on each server in the cluster or to a vol:\SYSTEM directory on the WebAccess Agent volume. Also specify where the MTA startup file will be stored.
Deciding Whether to Run the WebAccess Agent and Its MTA in Protected Memory

As with the MTA and the POA, you can choose whether to run the WebAccess Agent in protected memory. For a review of the benefits of protected memory, see “Deciding Whether to Run the Agents in Protected Memory” on page 32, which describes the issues in the context of planning MTA and POA installations.

You might think that protected memory would not be necessary if you have only one WebAccess Agent for your GroupWise system because it could never fail over to a server where another WebAccess Agent was running. However, because the WebAccess Agent in a cluster is installed into its own domain with its own MTA, this MTA could fail over to a server where another MTA was already running. Therefore, it is safest to load the WebAccess Agent and its MTA into protected memory.

Load the WebAccess Agent and its MTA into the same address space. They cannot communicate properly if one runs in protected memory and the other does not.

WEBACCESS CLUSTERING WORKSHEET

Under Item 9: Load WebAccess Agent and Its MTA in Protected Memory, mark whether or not you need to run the WebAccess Agent and its MTA in protected memory. If you do, provide a protected memory space name.

Planning the MTA Installation in a Cluster

Follow the instructions in “Planning the NLM Agent Installation in a Cluster” on page 33, then return to this point. After you follow the instructions, you will have a filled-out NLM Agent Worksheet to use when you install the MTA.

IMPORTANT: Do not install the NLM™ MTA until you are instructed to do so in “Setting Up WebAccess in a Cluster” on page 110.

Planning the WebAccess Installation in a Cluster

Aside from the cluster-specific issues discussed in the preceding sections, the considerations involved in planning to install WebAccess are the same in a clustering environment as for any other environment. Review "Planning GroupWise WebAccess," then print and fill out the "GroupWise WebAccess Installation Worksheet" in "Installing GroupWise WebAccess" in the
Planning the WebAccess Agent Installation

For the WebAccess Agent, fill out items 2 through 12 on the GroupWise WebAccess Installation Worksheet, taking into account the following cluster-specific issues:

WEBACCESS INSTALLATION WORKSHEET

Under Item 2: Installation Directory, take into account your decision recorded on the WebAccess Clustering Worksheet (Item 7: WebAccess Agent Installation Location).

Under Item 3: Server Address, transfer the IP address and port number from the WebAccess Clustering Worksheet (Item 8: WebAccess Agent Network Information) filled out during “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on page 107.

Under Item 4: Enable Clustering Support?, mark Yes. This will cause the WebAccess Installation program to customize the WebAccess files for clustering.

Under Item 5: Domain Directory Path, transfer the domain directory from the Domain Worksheet you filled out during “Planning a New Domain for the WebAccess Agent” on page 105.

Planning the WebAccess Application Installation

For the WebAccess Application, fill out items 13 through 19 on the GroupWise WebAccess Installation Worksheet, taking into account the following cluster-specific issues:

IMPORTANT: Do not install the WebAccess software until you are instructed to do so in “Setting Up WebAccess in a Cluster” on page 110.
You should already have reviewed “Planning WebAccess in a Cluster” on page 104 and filled out the “WebAccess Clustering Worksheet” on page 126. You are now ready to complete the following tasks to set up the WebAccess Agent in a clustering environment:

- “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 110
- “Creating a Domain for the WebAccess Agent” on page 111
- “Installing the MTA for the WebAccess Agent Domain” on page 111
- “Installing and Configuring the WebAccess Agent in a Cluster” on page 112
- “Installing and Configuring the WebAccess Application in a Cluster” on page 120
- “Testing Your Clustered WebAccess Installation” on page 122

## Cluster-Enabling a Shared Volume for Use with the WebAccess Agent

To cluster-enable the WebAccess Agent shared volume:

1. Complete the steps in "Cluster-Enable Volumes " in "Setting Up NetWare Cluster Services" in NetWare Cluster Services Overview and Installation.

Keep in mind these GroupWise-specific details:
In Step 3 in "Cluster-Enable Volumes," use the shared volume from WebAccess Agent Clustering Worksheet item 1.

In Step 4 in "Cluster-Enable Volumes," use the cluster volume IP address from WebAccess Agent Clustering Worksheet item 1.

In Step 5 in "Cluster-Enable Volumes," use the volume failover path from WebAccess Agent Clustering Worksheet item 3.

For a review of the new NDS® objects that are created when you cluster-enable a shared volume, see “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21.

To ensure successful short name resolution, add entries for the WebAccess Agent virtual server to support your preferred methods of short name resolution, as described in “Configuring Short Name Resolution” on page 44.

Continue with “Creating a Domain for the WebAccess Agent” on page 111.

Creating a Domain for the WebAccess Agent

The WebAccess Agent domain will be a secondary domain. To create it, follow the instructions in “Creating a New Secondary Domain in a Cluster” on page 49, taking your information from the WebAccess Clustering Worksheet, rather than the System Clustering Worksheet, then return to this point.

Do not create any post offices in the WebAccess Agent domain.

Continue with “Installing the MTA for the WebAccess Agent Domain” on page 111.

Installing the MTA for the WebAccess Agent Domain

The MTA for the WebAccess Agent domain can be installed just like any other MTA in your clustered GroupWise system. Follow the instructions in “Installing the Agent Software in a Cluster” on page 54, then return to this point.

You do not need to edit the MTA startup file. You do not need to modify the Volume Resource properties until after you have installed the WebAccess Agent.

Continue with “Installing and Configuring the WebAccess Agent in a Cluster” on page 112.
Installing and Configuring the WebAccess Agent in a Cluster

After you have created a domain for the WebAccess Agent and installed the MTA for that domain, you are ready to install and configure the WebAccess Agent.

- “Installing the WebAccess Agent Software in a Cluster” on page 112
- “Configuring the WebAccess Agent Volume Resource to Load and Unload the WebAccess Agent and Its MTA” on page 114

Installing the WebAccess Agent Software in a Cluster

The WebAccess Agent is the component of your WebAccess installation that accesses post offices and libraries to retrieve information for WebAccess client users.

To install the WebAccess Agent:

1. Map a drive to the WebAccess Agent volume (WebAccess Clustering Worksheet item 1) where the WebAccess domain is located.
   
The WebAccess Agent volume name will be cluster_volume. For assistance with mapping a drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 44.

2. If you selected vol:\SYSTEM on WebAccess Agent Volume as the WebAccess Agent installation location (WebAccess Clustering Worksheet item 7), create the vol:\SYSTEM directory on the WebAccess Agent volume accessed in Step 1.

or

If you selected SYS:\SYSTEM on Each Server, decide which server you will install the WebAccess Agent to first > map a drive to its SYS:\SYSTEM directory.

3. Start the WebAccess Installation program and install the NLM WebAccess Agent, following Step 1 and Step 2 provided in "Installing GroupWise WebAccess" in "Installing GroupWise WebAccess" in the Installation guide. Keep in mind the following cluster-specific details:

- In the Components dialog box, select only GroupWise WebAccess Agent.

    Do not install the WebAccess Application at this time.
Use items 2 through 12 on the GroupWise WebAccess Installation Worksheet that you filled out during “Planning the WebAccess Installation in a Cluster” on page 108 to fill in the fields during the WebAccess Agent installation process.

In the Installation Path dialog box, be sure to browse through the drive you mapped to the location you chose in Step 2 above.

In the Gateway Directory dialog box, be sure to browse to the domain directory through the drive you mapped in Step 1 above.

In the Start Applications dialog box, deselect Start the GroupWise WebAccess Agent.

The WebAccess Installation program creates the STRTWEB.NCF and STOPWEB.NCF files, which include the LOAD and UNLOAD commands for the WebAccess Agent. You will use this information later when you create the load and unload scripts for the WebAccess Volume Resource object.

4 If you need to install the WebAccess Agent to SYS\SYSTEM on multiple servers in the cluster, repeat Step 4, mapping new drives as needed.

or

If you installed the WebAccess Agent to a vol:\SYSTEM directory on the WebAccess Agent volume, copy the STRTWEB.NCF and STOPWEB.NCF files from SYS\SYSTEM on the server where the WebAccess Agent volume was mounted during installation to the vol:\SYSTEM directory on the WebAccess Agent volume.

The WebAccess Installation program currently insists on placing these .NCF files into SYS\SYSTEM even if you instructed it to do otherwise. This behavior will be corrected in Support Pack 1.

5 Make sure you have completed all the WebAccess Agent tasks described in “Setting Up GroupWise WebAccess” in “Installing GroupWise WebAccess” in the Installation guide, but do not start the WebAccess Agent at this time.

6 Continue with “Configuring the WebAccess Agent Volume Resource to Load and Unload the WebAccess Agent and Its MTA” on page 114.
Configuring the WebAccess Agent Volume Resource to Load and Unload the WebAccess Agent and Its MTA

The properties of the Volume Resource object define how the WebAccess Agent volume functions within the cluster, how NLM programs are loaded and unloaded, and how failover and failback situations are handled. Complete the following tasks for the WebAccess Agent volume:

- “Modifying the Volume Resource Load Script for the WebAccess Agent” on page 114
- “Modifying the Volume Resource Unload Script for the WebAccess Agent” on page 117
- “Setting the Failover Path and Policies for the WebAccess Agent” on page 118

Modifying the Volume Resource Load Script for the WebAccess Agent

The volume resource load script executes whenever the WebAccess Agent volume comes online.

To set up the load script:

1. In ConsoleOne™, browse to and select the Cluster object. If necessary, click View > Console View to display its contents.

2. Right-click the Volume Resource object (volume_SERVER) > click Properties > Load to display the default volume resource load script for the WebAccess Agent volume.

   The next step assumes that this is the first time you have edited the load script. If other GroupWise agents are already running from this volume, some of the modifications will already have been made.

3. Make the following changes to the default load script:
   
   - Remove the TRUSTMIG line. It is not necessary to migrate trustees for the WebAccess Agent volume. Removing this line helps the load script to execute faster.
   - If you are using SLP as a short name resolution method, as described in “Configuring Short Name Resolution” on page 44, add the CVSBIND ADD command for the WebAccess Agent volume to the load script.

        CVSBIND ADD cluster_volume_SERVER IP_address
Add the following abend recovery options:

```
SET AUTO RESTART AFTER ABEND = 2
SET AUTO RESTART AFTER ABEND DELAY TIME = 0
SET AUTO RESTART DOWN TIMEOUT = 60
SET DEVELOPER OPTION = OFF
```

These settings provide the best possible handling of GroupWise databases in the event that an abend should occur within the cluster.

If you selected `vol:\SYSTEM` on WebAccess Agent Volume as the installation location (WebAccess Clustering Worksheet items 5 and 7), add a SEARCH ADD command to add the new `vol:\SYSTEM` directory to the server search path.

```
SEARCH ADD volume:\\SYSTEM
```

If you selected `SYS:\SYSTEM` on Each Server as the installation location (WebAccess Clustering Worksheet items 5 and 7) but you are storing the MTA startup file on the WebAccess Agent volume, add that location to the server search path.

Transfer the MTA LOAD command from the `GRPWISE.NCF` file located in the `vol:\SYSTEM` directory into the load script. Use Ctrl+C and Ctrl+V to copy and paste text into the load script page. Then delete or rename the `GRPWISE.NCF` file to avoid future confusion.

```
LOAD volume:\\SYSTEM\GWMTA.NLM @domain.MTA
```

Add a delay so that the MTA is fully loaded before the WebAccess Agent starts to load:

```
LOAD DELAY
DELAY 10
```

The length of the delay varies from system to system; ten seconds is a good starting place.

Transfer the WebAccess Agent LOAD command from the `STRTWEB.NCF` file located in the `vol:\SYSTEM` directory into the load script. Use Ctrl+C and Ctrl+V to copy and paste text into the load script page.

```
LOAD volume:\\SYSTEM\GWINTER.NLM
/PH=volume:\domain\WPGATE\WEBAC60A
/USER=username /PASSWORD=password
```
If you selected Yes under Load WebAccess Agent and Its MTA in Protected Memory? (WebAccess Clustering Worksheet item 9), add the ADDRESS SPACE parameter to the LOAD commands to specify the protected address space where the WebAccess Agent and its MTA will run. Add a PROTECTION RESTART command for the address space name.

```
LOAD ADDRESS SPACE=addrspacename
  volume:\SYSTEM\GWMTA.NLM @domain.MTA
LOAD ADDRESS SPACE=addrspacename
  volume:\SYSTEM\GWINTER.NLM
   /PH=volume:\domain\WPGATE\WEBAC60A
   /USER=username /PASSWORD=password
PROTECTION RESTART name
```

The result would look similar to the following example:

4 Click Apply to save the load script.
5 Continue with “Modifying the Volume Resource Unload Script for the WebAccess Agent” on page 117.
Modifying the Volume Resource Unload Script for the WebAccess Agent

The volume resource unload script executes whenever the WebAccess Agent volume goes offline. Programs should be unloaded in the reverse order of how they were loaded. This ensures that supporting programs are not unloaded before programs that rely on them in order to function properly.

To set up the unload script:

1. In ConsoleOne, in the properties pages for the Volume Resource object \(volume\_SERVER\), click Unload to display the default volume resource unload script.

   The next step assumes that this is the first time you have edited the unload script. If other GroupWise agents are already running from this volume, some of the modifications will already have been made.

2. Make the following changes to the default unload script:
   - If you selected Yes under Load WebAccess Agent and Its MTA in Protected Memory (WebAccess Clustering Worksheet item 9), add an UNLOAD ADDRESS SPACE command and an UNLOAD KILL ADDRESS SPACE command to ensure that the address space is completely cleaned up.

     \[
     \begin{align*}
     &\text{UNLOAD ADDRESS SPACE=addrspacename} \\
     &\text{UNLOAD KILL ADDRESS SPACE=addrspacename}
     \end{align*}
     \]

     If your system seems to be trying to kill the address space before the WebAccess Agent and its MTA have been completely unloaded, resulting in the agents hanging in the unloading state, set a delay of several seconds before issuing the UNLOAD KILL ADDRESS SPACE command to allow the WebAccess Agent and its MTA adequate time to unload completely. The length of the delay varies from system to system; ten seconds is a good starting place.

     \[
     \begin{align*}
     &\text{UNLOAD ADDRESS SPACE=addrspacename} \\
     &\text{DELAY 10} \\
     &\text{UNLOAD KILL ADDRESS SPACE=addrspacename}
     \end{align*}
     \]

   - If you selected No under Load WebAccess Agent and Its MTA in Protected Memory? (WebAccess Clustering Worksheet item 9), create an UNLOAD command parallel to each LOAD command that you placed in the load script.

     \[
     \begin{align*}
     &\text{UNLOAD volume:\SYSTEM\GWINTER.NLM} \\
     &\text{UNLOAD volume:\SYSTEM\GWMTA.NLM}
     \end{align*}
     \]
If you are using SLP as a short name resolution method, add the CVSBIND DEL command for the WebAccess Agent volume to the unload script.

```
CVSBIND DEL cluster_volume_SERVER IP_address
```

Remove the TRUSTMIG line just like you did in the load script. The result would look similar to the following example:

![Properties of Sw/VOL SERVER](image)

3 Click Apply to save the unload script.

4 Continue with “Setting the Failover Path and Policies for the WebAccess Agent” on page 118.

### Setting the Failover Path and Policies for the WebAccess Agent

To modify the failover path and policies for the WebAccess Agent volume resource:

1 In ConsoleOne, in the properties pages for the Volume Resource object (volume_SERVER), click Nodes to display the default failover path for the WebAccess Agent volume resource.
2 Arrange the servers in the cluster into the desired failover path for the WebAccess Agent volume (WebAccess Clustering Worksheet item 4).

3 Click Apply to save the failover path.

4 Click Policies to display the default start, failover, and failback policies.

The default policy settings are often appropriate. By default, a volume resource:

- Fails over automatically if the server it is running on fails
Clustering

Starts automatically on the next server in its failover path
Continues running at its failover location, even after its most preferred server is again available

If you are considering changing these defaults, see "Set Start, Failover, and Failback Modes" in "Installation and Setup" in NetWare Cluster Services Overview and Installation.

5 Click OK when you are finished editing the WebAccess Agent volume resource properties.

6 Continue with “Installing and Configuring the WebAccess Application in a Cluster” on page 120.

Installing and Configuring the WebAccess Application in a Cluster

Recall that the WebAccess Agent is the component of your WebAccess installation that accesses post offices and libraries to retrieve information for WebAccess client users. The WebAccess Application provides the link between the WebAccess Agent and the WebAccess clients’ Web browsers.

To install the WebAccess Application:

1 Map a drive to the WebAccess Agent volume (WebAccess Clustering Worksheet item 1) where the WebAccess domain is located.

The WebAccess Agent volume name will be \cluster_volume. For assistance with mapping a drive to a cluster-enabled volume, see “Configuring Short Name Resolution” on page 44.

2 Map a drive to SYS:SYSTEM on the first server where you want to install the WebAccess Application (WebAccess Clustering Worksheet item 10).

3 If the server where you are going to install the WebAccess Application is currently running any applications that rely on Java or on the Netscape Enterprise Server, migrate those applications to another server in the cluster. If any GroupWise agents are running on the server, migrate the agents. For assistance with migrating resources, see "Migrate Resources" in "Installation and Setup" in NetWare Cluster Services Overview and Installation.

4 Manually stop the Netscape Enterprise Server and unload Java.

NSWEBDN
UNLOAD JAVA

120 Clustering
If the WebAccess Installation program detects that the Netscape Enterprise Server and Java are still running, it will attempt to stop them for you. However, the Installation program is not always successful, so performing this step manually is recommended.

5 Start the WebAccess Installation program as you did when you installed the WebAccess Agent (Step 3 on page 112). Keep in mind the following cluster-specific details:

- In the Components dialog box, select only GroupWise WebAccess Application.
- Use items 13 through 19 on the GroupWise WebAccess Installation Worksheet that you filled out during “Planning the WebAccess Installation in a Cluster” on page 108 to fill in the fields during the WebAccess Application installation process.
- In the Gateway Directory dialog box, be sure to browse to the WebAccess gateway directory (domain\WPGATE\WEBAC60A) through the drive you mapped in Step 1 above.
- In the Web Server Information dialog box, be sure to browse to the Web server’s root directory (SYS:\NOVONYX\SUITESPOT) through the drive you mapped in Step 2 above.
- In the Start Applications dialog box, deselect Restart Web Server.

6 Make sure you have completed all the WebAccess Application tasks described in "Setting Up GroupWise WebAccess" in "Installing GroupWise WebAccess" in the Installation guide.

7 Copy the SYS:\NOVONYX\SUITESPOT\DOCS\COM directory from the server where you just installed the WebAccess Application to the document root directory of the hardware virtual server (WebAccess Clustering Worksheet item 13).

8 At the server console, manually restart Java and the Netscape Enterprise Server.

   LOAD JAVA
   NSWEB

9 In the Cluster State View in ConsoleOne, offline and then online the Netscape Enterprise Server cluster resource, as well as any other Web server cluster resources that run on the server to reestablish their secondary IP addresses.
10 Repeat Step 2 through Step 9 for each server in the WebAccess Application failover path (WebAccess Clustering Worksheet item 13).

11 Continue with “Testing Your Clustered WebAccess Installation” on page 122.

Testing Your Clustered WebAccess Installation

Remember that the WebAccess Agent volume resource and the Netscape Enterprise Server cluster resource are separate resources that could fail over to different servers at different times.

To thoroughly test your WebAccess installation:

1 Make sure the initial combination of WebAccess Agent volume resource and Netscape Enterprise Server cluster resource is functioning properly.

2 Migrate the WebAccess Agent volume resource to each server on its failover path, making sure it functions with the initial Netscape Enterprise Server cluster resource.

3 Migrate the Netscape Enterprise Server cluster resource to a different server > migrate the WebAccess Agent volume resource to each server in its failover path > make sure each combination works.

4 Repeat Step 3 for each Netscape Enterprise Server cluster resource.

Managing WebAccess in a Cluster

After you have installed WebAccess in a cluster, you should consider some long-term management issues.

- “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 123
- “Knowing What to Expect in MTA and POA Failover Situations” on page 69
- “Updating the WebAccess Agent Configuration File (COMMGR.CFG)” on page 125
Updating GroupWise Objects with Cluster-Specific Descriptions

After installing WebAccess in your clustered GroupWise system, while the cluster-specific information is fresh in your mind, you should record that cluster-specific information as part of the GroupWise objects in ConsoleOne so that you can easily refer to it later. Be sure to update the information recorded in the GroupWise objects if the configuration of your system changes.

- “Recording Cluster-Specific Information about the Internet Agent Domain and Its MTA” on page 96
- “Recording Cluster-Specific Information about the Internet Agent” on page 96

Recording Cluster-Specific Information about the WebAccess Agent Domain and Its MTA

To permanently record important cluster-specific information for the WebAccess Agent domain:

1. In ConsoleOne, browse to and right-click the Domain object > click Properties.

2. In the Description field of the WebAccess Agent domain Identification page, provide a cluster-specific description of the WebAccess Agent domain, including the secondary IP address of its cluster-enabled volume and the cluster-unique port numbers used by its MTA.

You may also want to include cluster-specific information about the WebAccess Application, such as the secondary IP address of the Netscape Enterprise Server cluster resource where the WebAccess Application is installed.

3. Click OK to save the WebAccess Agent domain description.

4. Select the WebAccess Agent Domain object to display its contents.

5. Right-click the MTA object > click Properties.

6. In the Description field of the MTA Identification page, record the secondary IP address of the cluster-enabled WebAccess Agent domain volume and the cluster-unique port numbers used by the MTA.

   This information will appear on the MTA console, no matter which server in the cluster it is currently running on.

7. Click OK to save the MTA description.

8. Continue with “Recording Cluster-Specific Information about the Internet Agent” on page 96.
Recording Cluster-Specific Information about the WebAccess Agent

With the contents of the WebAccess Agent domain still displayed,

1. Right-click the WEBAC60A object > click Properties.
2. Click GroupWise > Identification.
3. In the Description field, record the secondary IP address of the cluster-enabled WebAccess Agent domain volume and the cluster-unique port numbers used by the WebAccess Agent.

   This information will appear on the WebAccess Agent console, no matter which server in the cluster it is currently running on.

4. Click OK to save the WebAccess Agent information.
5. Continue with “Knowing What to Expect in MTA and POA Failover Situations” on page 69.

Knowing What to Expect in WebAccess Failover Situations

The failover behavior of the MTA for the WebAccess Agent domain will be the same as for an MTA in a regular domain. See “Knowing What to Expect in MTA and POA Failover Situations” on page 69.

The WebAccess Application caches users’ credentials on the server where it is running. Therefore, if that server fails, or if the WebAccess Application migrates to a different server, the cached credentials are lost. Consequently, the user will need to restart the WebAccess client in order to re-authenticate and re-establish the credentials.

If the WebAccess Agent fails over or migrates, the user receives an error message that the WebAccess Agent is not longer available. However, after the WebAccess Agent starts in its new location, the WebAccess Application passes the cached user credentials to the WebAccess Agent and the user reconnects automatically without having to re-authenticate.

As with the MTA and the POA, migration of the WebAccess Agent takes longer than failover. However, the WebAccess Agent restarts quickly so that users are able to reconnect quickly.
Updating the WebAccess Agent Configuration File (COMMGR.CFG)

As part of installing WebAccess, the WebAccess Agent configuration file (COMMGR.CFG) is created in the domain\WPGATE\WEBAC60A subdirectory and is automatically copied to the Web server’s SYS:\NOVELL\WEBACCESS subdirectory. If you change WebAccess Agent configuration information (for example, if you change its IP address), the information is changed in the domain\WPGATE\WEBAC60A\COMMGR.CFG file because the domain is on a cluster-enabled volume, and it is changed in the SYS:\NOVELL\WEBACCESS\COMMGR.CFG file on the server where the WebAccess Application is currently running, but the other servers on the WebAccess Application’s failover path are not currently available for update. Therefore, you must manually copy the updated COMMGR.CFG file to the SYS:\NOVELL\WEBACCESS subdirectory on each server in the WebAccess Application’s failover path.
WebAccess Clustering Worksheet

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Shared Volume for WebAccess Agent:</td>
<td>Specify the name (cluster_volume) of the shared volume where the WebAccess Agent domain will be created.</td>
</tr>
<tr>
<td>Cluster Enabled?</td>
<td>For cluster-enabling, specify the IP addresses of the virtual server (volume_SERVER.cluster) to which the cluster-enabled volume is tied.</td>
</tr>
<tr>
<td>• Yes (highly recommended)</td>
<td>For more information, see “Deciding Whether to Cluster-Enable the WebAccess Agent Volume” on page 106.</td>
</tr>
<tr>
<td>• No</td>
<td></td>
</tr>
<tr>
<td>Cluster volume IP address</td>
<td></td>
</tr>
<tr>
<td>2) WebAccess Agent Domain Name:</td>
<td>Specify a unique name for the WebAccess Agent domain. Specify the directory on the WebAccess Agent volume where you want to create the new domain.</td>
</tr>
<tr>
<td>Domain Database Location:</td>
<td>For more information, see “Planning a New Domain for the WebAccess Agent” on page 105.</td>
</tr>
<tr>
<td>3) WebAccess Agent Failover Path:</td>
<td>List other servers in the cluster where the WebAccess Agent and its MTA could fail over.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Determining an Appropriate Failover Path for the WebAccess Agent Volume” on page 106.</td>
</tr>
<tr>
<td>4) MTA Installation Location:</td>
<td>Mark the location where you will install the MTA software. If necessary, specify the location where you will consolidate multiple MTA startup files on a WebAccess Agent volume.</td>
</tr>
<tr>
<td>• vol:\SYSTEM on WebAccess Agent volume</td>
<td></td>
</tr>
<tr>
<td>• SYS:\SYSTEM on each server</td>
<td>For more information, see “Deciding Where to Install the WebAccess Agent and Its MTA” on page 107.</td>
</tr>
<tr>
<td>Consolidate multiple MTA startup files on WebAccess Agent volume?</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>5) MTA Network Information:</td>
<td>Gather the MTA network address information from the “IP Address Worksheet” on page 39. For more information, see “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on page 107.</td>
</tr>
<tr>
<td>• MTA IP address</td>
<td></td>
</tr>
<tr>
<td>• MTA message transfer port</td>
<td>For more information, see “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on page 107.</td>
</tr>
<tr>
<td>• MTA live remote port</td>
<td></td>
</tr>
<tr>
<td>• MTA HTTP port</td>
<td></td>
</tr>
<tr>
<td>6) WebAccess Agent Installation Location:</td>
<td>Mark the location where you will install the WebAccess Agent software. For more information, see “Deciding Where to Install the WebAccess Agent and Its MTA” on page 107.</td>
</tr>
<tr>
<td>• vol:\SYSTEM on WebAccess Agent volume</td>
<td></td>
</tr>
<tr>
<td>• SYS:\SYSTEM on each server</td>
<td></td>
</tr>
<tr>
<td>7) WebAccess Agent Network Information:</td>
<td>Gather the WebAccess Agent network address information from the “IP Address Worksheet” on page 39. For more information, see “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on page 107.</td>
</tr>
<tr>
<td>• WebAccess Agent IP address</td>
<td></td>
</tr>
<tr>
<td>• WebAccess Agent HTTP port</td>
<td>For more information, see “Planning a Secondary IP Address and Cluster-Unique Port Numbers for the WebAccess Agent and Its MTA” on page 107.</td>
</tr>
<tr>
<td>8) Load WebAccess Agent and Its MTA in Protected Memory?</td>
<td>Mark whether you need to run the WebAccess Agent and its MTA in protected memory. If so, specify a unique address space. For more information, see “Deciding Whether to Run the WebAccess Agent and Its MTA in Protected Memory” on page 108.</td>
</tr>
<tr>
<td>• No</td>
<td></td>
</tr>
<tr>
<td>• Yes</td>
<td></td>
</tr>
<tr>
<td>Protected address space</td>
<td>For more information, see “Deciding Whether to Run the WebAccess Agent and Its MTA in Protected Memory” on page 108.</td>
</tr>
<tr>
<td>9) Physical Web Servers:</td>
<td>List the NetWare servers in the cluster where you are installing the Netscape Enterprise Server for use with WebAccess. For more information, see “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster” on page 104.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Explanation</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>10) Netscape Enterprise Server IP Address:</td>
<td>Record the secondary IP address for the Netscape Enterprise Server cluster resource, shown in the cluster resource load script. For more information, see “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster” on page 104.</td>
</tr>
<tr>
<td>11) Netscape Enterprise Server Mode:</td>
<td>Mark whether the Netscape Enterprise Server runs simultaneously on multiple servers in the cluster (active/active) or whether it runs on only one server at a time (active/passive). For more information, see “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster” on page 104.</td>
</tr>
<tr>
<td>12) Netscape Enterprise Server Failover Path:</td>
<td>List other servers in the cluster where the Netscape Enterprise Server can fail over. The WebAccess Application always fails over along with the Netscape Enterprise Server. For more information, see “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster” on page 104.</td>
</tr>
<tr>
<td>13) Hardware Virtual Server Information:</td>
<td>Record the hardware virtual server information for your shared disk system. For more information, see “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster” on page 104.</td>
</tr>
<tr>
<td>• Dedicated IP address:</td>
<td></td>
</tr>
<tr>
<td>• Document root</td>
<td></td>
</tr>
</tbody>
</table>
WebAccess Quick Checklist

- Plan the new clustered WebAccess installation, including the new domain required to house the WebAccess Agent in a clustering environment.
  See “Planning WebAccess in a Cluster” on page 104.

- Install and set up the Netscape Enterprise Web Server for NetWare in a cluster.
  See “Setting Up the Netscape Enterprise Web Server for NetWare in a Cluster” on page 104.

- Cluster-enable the volume where the WebAccess Agent domain will reside.
  See “Cluster-Enabling a Shared Volume for Use with the WebAccess Agent” on page 110.

- Create the new WebAccess Agent domain.
  See “Creating a Domain for the WebAccess Agent” on page 111.

- Set up the MTA for the new WebAccess Agent domain.
  See “Installing the MTA for the WebAccess Agent Domain” on page 111.

- Install the WebAccess Agent.
  See “Installing and Configuring the WebAccess Agent in a Cluster” on page 112.

- Modify the WebAccess Agent volume resource load script:
  - Remove the TRUSTMIG command
  - Add the CVSBIND ADD command (optional)
  - Add the SET AUTO RESTART commands
  - Add the SET DEVELOPER OPTION = OFF command
  - Add the SEARCH ADD command (optional)
  - Add the LOAD commands for the MTA and the WebAccess Agent, separating them with a DELAY command
  - Add the ADDRESS SPACE parameter to the LOAD commands and add a PROTECTION RESTART command for the name space (optional)
See “Modifying the Volume Resource Load Script for the WebAccess Agent” on page 114.

- Modify the WebAccess Agent volume resource unload script:
  - Add the MTA and WebAccess Agent or address space UNLOAD command(s)
  - Add the CVSBIND DEL command if you used the CVSBIND ADD command in the load script
  - Remove the TRUSTMIG command

See “Modifying the Volume Resource Unload Script for the WebAccess Agent” on page 117.

- Set up the WebAccess Agent volume failover path and policies.
  See “Setting the Failover Path and Policies for the WebAccess Agent” on page 118.

- Add the WebAccess Application to each server where the Netscape Enterprise Server is installed.
  See “Installing and Configuring the WebAccess Application in a Cluster” on page 120.

- Test the clustered WebAccess Agent.
  See “Testing Your Clustered WebAccess Installation” on page 122.

- Record cluster-specific information in the properties pages of the GroupWise objects associated with the WebAccess Agent.
  See “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 123.
Implementing GroupWise Gateways in a Cluster

A significant system configuration difference between a GroupWise® system in a clustering environment and a GroupWise system in a regular environment is that you need to create a separate domain to house each GroupWise gateway. The gateway domain should be created on a cluster-enabled volume. This enables the gateway to fail over independently from other GroupWise components.

If you have set up the Internet Agent or WebAccess in your clustered GroupWise system, you should already have the skills necessary to set up a GroupWise gateway as well.

GroupWise gateways that have not received recent development have not been thoroughly tested in a clustering environment. If you are still using such GroupWise gateways, you may want to leave them outside of your cluster.
7 Monitoring a Clustered GroupWise System

Because the GroupWise® 6 Monitor currently runs on Windows® NT*/2000, rather than NetWare®, you cannot run GroupWise Monitor in a cluster. However, GroupWise Monitor can easily monitor a clustered GroupWise system from a vantage point outside the cluster.

When you first install Monitor, it gathers information about agents to monitor from a domain database (WPDOMAIN.DB). This provides the secondary IP address of each agent (the IP address associated with the cluster-enabled volume where the agent’s domain or post office resides). When an agent fails over or migrates to a different server, its status in Monitor displays as Not Listening until it is up and running again, at which time its status returns to Normal.

Because Monitor must use secondary IP addresses to monitor the agents in a clustered GroupWise system, the Discover Machine and Discover Network options do not work in a cluster. Secondary IP addresses cannot be obtained by examining the network itself. If you need to add agents to monitor, use the Add Agent option and provide the agent’s secondary IP address.

For instructions on setting up GroupWise Monitor, see "Installing GroupWise Monitor" in the Installation guide.
Backing Up a Clustered GroupWise System with the GroupWise TSA

The GroupWise® Target Service Agent (GWTSA) provides reliable backups of a running GroupWise system by successfully backing up open files and locked files, rather than skipping them as some backup software does. The GWTSA can be used in a clustered GroupWise system with appropriate preparation and understanding of how the GWTSA works. For background information on the GWTSA, see "GroupWise Target Service Agent (GWTSA)" in "Databases" in the Administration guide.

In a clustering environment, the GWTSA must be installed and loaded on each server where backups will be performed. The GWTSA cannot currently run in protected memory, so if the server where it is running fails, the backup does not run to completion. There is currently no way to restart a backup from a checkpoint position.

To accommodate the variable locations of data to back up in a clustered GroupWise system, the GWTSA.NCF file of each server should be edited to include a /home switch for every domain and post office on every cluster-enabled volume that might ever be mounted on that server. When the GWTSA runs, it checks the accessibility of each location. It backs up those that are currently accessible and skips those that are not accessible, so that the backup runs successfully, even if some locations are currently inaccessible.

If a data location becomes unavailable during a backup that is already running, the GWTSA cannot remain in contact with the location as it fails over. Therefore, the backup will need to be rerun after the location is again accessible.
Adding Novell Cluster Services to an Existing GroupWise 6 System

If you are adding the high availability benefits of Novell® Cluster Services™ to a GroupWise® 6 system that is already up and running, the first step is to install Novell Cluster Services following the instructions in NetWare Cluster Services Overview and Installation. You should also review Chapter 1, “Introduction to GroupWise 6 and Novell Cluster Services,” on page 11 to help you apply clustering principles and practices to your GroupWise system.

You do not need to transfer your entire GroupWise system into the cluster all at once. You could transfer individual post offices where the needs for high availability are greatest. You could transfer a domain and all of its post offices at the same time. You may decide that you don’t need to have all of your GroupWise system running in the cluster.

This section provides a checklist to help you get started with moving your GroupWise system into a clustering environment:

- Decide which shared volumes in your shared disk system you will use for GroupWise domains and post offices.
- Decide which servers in your storage area network you will have on failover paths for the GroupWise agents.
- Review Chapter 2, “Planning GroupWise in a Clustering Environment,” on page 15. Fill out the “System Clustering Worksheet” on page 35 to help you decide which domains and post offices you will move to which shared volumes.
Review “Planning Secondary IP Addresses and Cluster-Unique Port Numbers for Agents in the Cluster” on page 26 and fill out the “IP Address Worksheet” on page 39 to select secondary IP addresses for cluster-enabled volumes and to specify cluster-specific port numbers for all of your GroupWise agents.

Select the first shared volume that will be part of your clustered GroupWise system and cluster-enable it, following the instructions in “Cluster-Enabling Shared Volumes for Use with GroupWise” on page 44 and “Configuring Short Name Resolution” on page 44.

Move a domain and/or post office onto the cluster-enabled volume, following the instructions in “Moving a Domain” in "Domains" or "Moving a Post Office" in "Post Offices" in the Administration guide.

Review “Deciding How to Install and Configure the Agents in a Cluster” on page 26, fill out the “Agent Clustering Worksheet” on page 40, and install the agents as needed for the first clustered domain and/or post office, following the instructions in “Installing and Configuring the MTA and the POA in a Cluster” on page 53. This includes setting up the load and unload scripts for the cluster-enabled volume.

Test the first component of your clustered GroupWise system following the instructions in “Testing Your Clustered GroupWise System” on page 65.

Take care of the cluster management details described in “Managing Your Clustered GroupWise System” on page 67.

Move more domains and post offices into the cluster as needed. If you have GroupWise libraries, see “Planning a New Library for a Clustered Post Office” on page 21.

Add other components to your clustered GroupWise system as needed, following the instructions in:

- Chapter 4, “Implementing the Internet Agent in a Cluster,” on page 77
- Chapter 6, “Implementing GroupWise Gateways in a Cluster,” on page 131
- Chapter 7, “Monitoring a Clustered GroupWise System,” on page 133
- Chapter 8, “Backing Up a Clustered GroupWise System with the GroupWise TSA,” on page 135
Chapter 10
Updating a Clustered GroupWise 5.x System to GroupWise 6

The basic process of updating from GroupWise® 5.x to GroupWise 6 (with Support Pack 1) is the same in a clustered GroupWise system as in a regular GroupWise system. In preparation for updating your GroupWise system, review "Update" in the Installation guide. This section focuses particularly on cluster-specific issues that will arise as you update from GroupWise 5.x to GroupWise 6.

- “Cluster-Enabling GroupWise Volumes” on page 139
- “Updating GroupWise Administration in a Cluster” on page 140
- “Updating Domains, Post Offices, and Agents in a Cluster” on page 140
- “Updating the Internet Agent in a Cluster” on page 143
- “Updating WebAccess in a Cluster” on page 144

Cluster-Enabling GroupWise Volumes

Placing domains and post offices on cluster-enabled volumes is highly recommended for GroupWise 6. For a discussion of the benefits of cluster-enabling, see “Deciding Whether to Cluster-Enable the Shared Volumes Used by GroupWise” on page 21.

If at all possible, you should reconfigure your cluster so that domains and post offices reside on cluster-enabled volumes. Make sure your GroupWise 5.x system functions properly with cluster-enabled volumes before updating it to GroupWise 6 Support Pack 1.

IMPORTANT: Because cluster-enabling the volumes where domains and post offices reside is so strongly recommended, this documentation does not include the steps for setting up domains and post offices on non-cluster-enabled volumes.
If you decide not to cluster-enable GroupWise volumes, you will need to adjust the steps presented in this documentation for your system's specialized needs.

Continue with “Updating GroupWise Administration in a Cluster” on page 140.

**Updating GroupWise Administration in a Cluster**

If ConsoleOne™ and the GroupWise snap-ins have been installed on a cluster-enabled volume on the network, rather than on individual administrator workstations, map a drive to that location so that the GroupWise administration software can be updated.

If you created your GroupWise software distribution directory on a cluster-enabled volume, map a drive to that location. If you will continue to have GroupWise 5.x components in your GroupWise 6 system, create a new software distribution directory for the GroupWise 6 software. GroupWise client users will install the GroupWise 6 client from the software distribution directory, as described in "Updating Users' GroupWise Clients" in "Update" in the Installation guide.

Run the GroupWise Installation Advisor as described in "Installing the GroupWise 6 Software" in "Update" in the Installation guide. Be sure to browse through the mapped drives to any locations on cluster-enabled volumes.

Continue with “Updating Domains, Post Offices, and Agents in a Cluster” on page 140.

**Updating Domains, Post Offices, and Agents in a Cluster**

As with a regular update, you must update the primary domain of your clustered GroupWise system first, whether it is part of the cluster or not. After you have updated the primary domain, you can proceed with updating the post offices in the primary domain, or you can update secondary domains.

The update process occurs as you update the agents that service each domain and post office in your clustered GroupWise system. You can use the GroupWise Installation Advisor or the Agent Installation program to accomplish this, as described in "Updating the Primary Domain," "Updating

- “Sequencing the Update” on page 141
- “Preparing for the Update” on page 142
- “Installing the Update” on page 142
- “Checking Agent Startup Files and the Volume Resource Load Script” on page 143
- “Updating the POA on the Same Server as the MTA” on page 143

After completing the tasks above, continue with “Updating the Internet Agent in a Cluster” on page 143

**Sequencing the Update**

You do not need to update your entire clustered GroupWise system at the same time. However, sequencing of updates is important:

- Install GroupWise 6 Support Pack 1, not the original version of GroupWise 6.
- Update the primary domain first.
- Update each secondary domain before you update the post offices that belong to that domain.
- If multiple domains and/or post offices are part of the same volume resource, update them all at the same time.
- If you have installed the agent software to multiple SYS:\SYSTEM directories, rather than to a vol:\SYSTEM directory on a GroupWise volume, update all the SYS:\SYSTEM directories at the same time.

Check failover paths to make sure that a GroupWise volume that still has GroupWise 5.x domains and/or post offices cannot fail over to a server where the GroupWise 6 agents are being installed. If this happens, the GroupWise 5.x databases will be automatically updated to GroupWise 6 as soon as the GroupWise 6 agents run against them.
Preparing for the Update

Complete the following preparation before starting to install the GroupWise 6 agent software:

- Stop the GroupWise agents that are running from the currently installed software location. Typically, you would offline the volume resource to stop the agents, but when you are updating the agent software, the volume resource needs to be available but without any agents running.
- Make sure you know the current location of the agent software you are updating (SYS\SYSTEM on multiple servers or vol:\SYSTEM on the GroupWise volume).
- Map a drive to the GroupWise volume where the domain and/or post office to update is located.
- If necessary, map a drive to the first SYS\SYSTEM directory to update.

Installing the Update

As you run the GroupWise Installation Advisor or the Agent Installation program to update a domain and/or post office, keep in mind the following cluster-specific details:

- Be sure to always browse to the database location through the mapped drive.
- In the Installation Path dialog box, be sure to select Configure GroupWise Agents for Clustering.
- If you are prompted about an existing GRPWISE.NCF file, recall that, for cluster-enabled volumes, the load commands for the agents are typically transferred from the GRPWISE.NCF file into the cluster resource load script. Therefore, an existing GRPWISE.NCF file should not be in use. Have the Installation program create a GRPWIS1.NCF so that you can compare the load commands generated during the update installation with the load commands that are currently in the volume resource load script.
- Do not start the agents at the end of the installation process.
Checking Agent Startup Files and the Volume Resource Load Script

After the GroupWise Installation Advisor or Agent Installation program has finished, check the new MTA and POA startup files to make sure they have the same names as the previous versions. Because you type in the domain and post office names that are used to generate the startup file names, inadvertent changes can occur.

In ConsoleOne, offline the GroupWise volume. Examine the volume resource load script and compare the load commands in the load script with the GRPWISE.NCF file created during the update installation. If necessary, modify the load script to match the load commands in the GRPWISE.NCF file, then delete or rename the new GRPWISE.NCF file to avoid future confusion. Online the GroupWise volume.

Updating the POA on the Same Server as the MTA

If the MTA and the POA will run together on the same server and from the same directory, there is an additional step in the update process. When you online the GroupWise volume, the MTA and the POA will start at the same time. The MTA will immediately rebuild the domain database (WPDOMAIN.DB) into GroupWise 6 format. For a large domain database, this can be a lengthy process. You can tell when the process is finished by checking the domain Identification page in ConsoleOne. When the Database Version field displays 6, the update is complete.

After the domain database has been rebuilt, you must restart any POAs that are running on the same server with the MTA, so that they can update their post office databases (WPHOST.DB) into GroupWise 6 format. The post office Identification page also has a Database Version field that will display 6 when the update is complete.

Updating the Internet Agent in a Cluster

Before updating the Internet Agent in your clustered GroupWise system, review "Updating the GroupWise Internet Agent" in "Update" in the Installation guide. Based on the capabilities of the GroupWise 6 Internet Agent, you may choose not to update the Internet Agent until after you have updated all the domains and post offices in your clustered GroupWise system.

If it is important to provide the new features of the GroupWise 6 Internet Agent while some parts of your clustered GroupWise system are still running...
GroupWise 5.x, you can set up a new GroupWise 6 Internet Agent, following the steps provided in Chapter 4, “Implementing the Internet Agent in a Cluster,” on page 77. As you update each domain to GroupWise 6, you can configure that domain to use the GroupWise 6 Internet Agent. In ConsoleOne, right-click a Domain object > click Properties > GroupWise > Internet Addressing. Select Override next to Internet Agent for Outbound SMTP/MIME Messages > select the GroupWise 6 Internet Agent.

After your entire clustered GroupWise system has been updated to GroupWise 6, you can change the system default Internet Agent under Tools > GroupWise System Operations > Internet Addressing to the GroupWise 6 Internet Agent and then remove the domain-level overrides. You should also delete the GroupWise 5.x GWIA object and its accompanying directory structure from your GroupWise system to avoid future confusion.

Continue with “Updating WebAccess in a Cluster” on page 144.

### Updating WebAccess in a Cluster

Before updating WebAccess in your clustered GroupWise system, review "Updating GroupWise WebAccess" in "Update" in the Installation guide. Based on the capabilities of the GroupWise 6 WebAccess Agent, you may choose to continue using the GroupWise 5.x WebAccess Agent to service domains and post offices that are still running GroupWise 5.x, while setting up a new GroupWise 6 WebAccess Agent to service those domains and post offices that you update to GroupWise 6.

- “Updating the WebAccess Agent” on page 144
- “Updating the WebAccess Application” on page 145

### Updating the WebAccess Agent

To set up a new GroupWise 6 WebAccess Agent, follow the steps in Chapter 5, “Implementing WebAccess in a Cluster,” on page 103, but do not immediately install the WebAccess Application to your Web servers. As you update each domain and post office to GroupWise 6, you can configure individual post offices or an entire domain to use the GroupWise 6 WebAccess Agent. In ConsoleOne, right-click a Domain or Post Office object > click Properties > GroupWise > Default WebAccess. Select Override next to Default WebAccess Gateway > select the GroupWise 6 WebAccess Agent.
After your entire clustered GroupWise system has been updated to GroupWise 6, you can remove the GroupWise 5.x WebAccess Agent. Click the Domain object where the GroupWise 5.x WebAccess Agent is installed > right-click the GroupWiseProvider object > click Properties. In the GroupWise WebAccess Agents list, select the GroupWise 5.x WebAccess Agent > click Delete. You should also delete the GroupWise 5.x WebAccess Agent object and its accompanying directory structure from your GroupWise system to avoid future confusion.

**Updating the WebAccess Application**

GroupWise 5.x versions of the WebAccess Agent cannot work with the GroupWise 6 WebAccess Application. Therefore, you should not update the WebAccess Application on your Web servers until all domains and post offices have been updated to GroupWise 6. To update the WebAccess Application to GroupWise 6, follow the steps in “Installing and Configuring the WebAccess Application in a Cluster” on page 120.